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Introduction	 Abstract Plus Abstractor Training Manual 

Chapter  1:   Introduction  
Overall Learning Objectives 
These are the overall learning objectives for this Abstract Plus training manual for 
Abstractors: 

	 Learn how to Log in into Abstract Plus 

	 Learn about the Abstract Plus menu items 

	 Become familiar with the basic steps for abstracting using Abstract Plus 

	 Learn how to begin abstracting by starting a new abstract, opening an existing abstract, or 
copying an existing abstract 

	 Become familiar with the abstracting features of Abstract Plus, including entering text 
fields, coding histologic type, and coding and deriving Collaborative Staging fields 

	 Learn about the Abstract Plus editing features and how to correct edit errors 

	 Learn how to print abstracts 

	 Learn how to export abstracts out of Abstract Plus 

	 Become familiar with Abstract Plus Utilities 

	 View, print, and save available abstract reports, and run custom reports 

Overview of the Abstract Plus Abstractor Training Manual 
The Abstract Plus Abstractor Training Manual provides you with the information to 
understand and use the abstracting features of Abstract Plus.  This manual describes the 
functions available to the Abstractor. The major sections include logging in to Abstract Plus, 
abstracting information, editing abstracted information, completing abstracts, exporting 
abstracts, using utilities, and viewing abstract reports.  Also, each chapter contains questions 
that test your knowledge of the Abstract Plus abstracting features and activities that allow 
you to practice your new skills on your own. 

Abstract Plus Features 
Abstract Plus version 3.1 is a free-of-charge, cancer data collection tool developed by the 
Centers for Disease Control and Prevention (CDC) that supports two main functions: 
abstracting and auditing. The application can be customized by central cancer registries to be 
used centrally, as well as for distribution to and use by hospitals and other reporting sources.  
Although the product is not designed to include all functionality needed in an American 
College of Surgeons (ACoS)-approved hospital cancer registry, it is suitable for reporting to 
central registries from non-registry hospitals, clinics, laboratories, and other sources for 
cancer incident reports. The program can also be used for special projects and start-up 
registries. 

The abstracting capability of Abstract Plus is used to summarize medical records into an 
electronic report of cancer diagnosis and treatment by abstractors or anyone working with 
cancer data. Abstract Plus supports the abstraction of all data items in national standard data 
sets, including all text fields, as well as any state-specific data items. The output of Abstract 
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Abstract Plus Abstractor Training Manual Introduction 

Plus is an electronic abstract in the format of the North American Association of Central 
Cancer Registries (NAACCR) data exchange layout. 

Abstracts entered into Abstract Plus are validated by customizable edits, allowing for 
interactive error correction while abstracting. Abstract Plus includes Registry Plus Online 
Help, a collection of standard coding manuals that are cross-referenced, indexed, and 
context-linked to minimize the need for reference to printed manuals during abstracting. 

The all-new auditing capability included in Abstract Plus version 3.1 allows central registries 
to use the program to perform case completeness and data quality audits of reporting 
facilities, as well as data quality audits of central registry abstractors. For assessing case 
completeness, casefinding audits are available, and for assessing data quality, both 
reabstraction and recoding audits are available.  The application allows for either blinded or 
un-blinded reabstraction audits, and for recoding audits, un-blinded submitted text can be 
recoded for both reporting facilities as well as central registry abstractors. 

Please note that due to development priorities, Abstract Plus version 3.1 is being 
released without the Auditor features; description of Auditor features provided in this 
manual is for informational purposes only. The Auditor features of Abstract Plus will 
be released in a future version of the program. 
Abstract Plus version 3.1 has been entirely reprogrammed using .NET technology. The 
application has a new, more user-friendly abstracting interface.  New direct grid entry of 
coded values allows for a more streamlined abstracting experience, as well as easier viewing 
of text fields, online help, and edit errors. 

Abstract Plus version 3.1 also has enhanced security features.  All records are saved in 
Microsoft Access or SQL server databases, and all tables are password protected and 
encrypted using Microsoft functions. All users must have a User ID and password to access 
the abstracting features of the application, and access to administrative and auditor functions 
requires the entry of special restricted passwords. A security challenge question feature is 
also included in case a user forgets his or her password, which enables the user to securely 
reset their password without administrator intervention. 

Abstract Plus User Roles 
Abstract Plus users consist of abstractors, central cancer registrars, and other individuals or 
groups who work with cancer data. Abstract Plus includes 3 types of users, or roles: 

User Description 

Abstractor/ 
General User 

The Abstractor or general user manages data entry and has access to all of 
the abstracting features of the program. 
Abstractors can add new abstracts, edit existing abstracts, copy, print, and 
delete abstracts, and can import and export abstracts in NAACCR file 
format.  Abstractors can also view available reports and update their 
password and personal security challenge questions. 
All Abstractors must have a user account, and log in to the application 
using a User ID and password. 

Version 2.0 February 2011 2 
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User Description 

Auditor 

The Auditor manages audit entry and reporting and has access to all of the 
abstracting features of the program described above for the general user; 
however, Auditors also have access to all of the auditing features of the 
program. 
Auditors can open and close audits, and perform casefinding, 
reabstraction, and recoding audits (including pre- and post-reconciliation 
tasks), and run available audit reports.  Auditors can also export newly 
identified tumors in NAACCR file format from casefinding efforts, and 
can export completed reabstraction and recoding audits. 
All Auditors must have a general user account, and log in to the 
application using a User ID and password.  Auditors access auditing 
functions using a special Auditor password. 

Administrator 

The Administrator manages the setup of the program and has access to all 
of the abstracting features of the program described above for the general 
user and all of the auditing features available to the Auditor; however 
Administrators have access to additional administrative features of the 
program. They can perform administrative functions such as managing 
the Administrator password, creating and modifying general user 
accounts, specifying application preferences, creating and managing 
abstracting display types, and creating and managing audit display types, 
discrepancy codes and databases.  
All Administrators must have a general user account, and log in to the 
application using a User ID and password.  Administrators access 
administrative functions using a special Administrator password. Entry of 
the Administrator password also allows access to all auditing functions 
(i.e., entry of the Auditor password is not required for Administrators). 

System Requirements 
Abstract Plus is programmed for the Microsoft Windows 32-bit environment installed on an 
Intel Pentium or Pentium-compatible computer. The minimum hardware requirements are the 
same as those of the Microsoft Windows operating system used. Additional system 
requirements include: 

	 Microsoft operating system from Windows 98 through Windows Vista 

	 128 MB RAM (512 MB minimum recommended) 

	 Latest version of Microsoft Internet Explorer (recommended) 

	 The available hard-disk space requirement for Abstract Plus depends on the 
number of abstracts that will be created and maintained in the database. A 
minimum of 70 MB of free hard drive space is required. 
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Abstract Plus Abstractor Training Manual 	 Introduction 

Downloading and Installing Abstract Plus 
A generic (non-customized) version of Abstract Plus is available from the CDC’s Registry 
Plus Web site (http://www.cdc.gov/cancer/npcr/). This Web site provides a fully documented 
generic installation, downloadable fact sheets, and version enhancement information. 

Please note, however, most users will require a customized version of the software set up to 
meet requirements and procedures of a specific locale, usually a state, or for a specific study. 
Potential users of Abstract Plus should contact their state central cancer registry staff 
first to inquire about their customized version and for support. State registry contact 
information can be found at the National Program of Cancer Registries Web site:  
http://apps.nccd.cdc.gov/cancercontacts/npcr/contactlist.asp. 

You must have administrative privileges to your computer in order to
 
install Abstract Plus.  Contact your system administrator to install the
 
program if you do not have administrative privileges. 


To download and install Abstract Plus, complete these steps:
   

1.	 Open your Internet browser and type in the following URL for the NPCR web site in the 
address field: 

http://www.cdc.gov/cancer/npcr/ 

2.	 Press Enter. 

3. In the Featured Items section, Under Tools, click the Registry Plus link. 

4. In the Registry Plus Components section, click the Abstract Plus link. 

5.	 Click the Technical Information and Installation link. 

6. Read the information provided in the section Installing and Upgrading Abstract Plus. 

7.	 Scroll down to the Installation section, and click the Download Abstract Plus link. 

8.	 To download the latest version of Abstract Plus, click the link to the latest .exe file. 

9.	 Click Run on the displayed page and follow all the prompts to download and install 
Abstract Plus. 

If you have a prior version of Abstract Plus installed on your computer, 
and would like to upgrade to Abstract Plus version 3.1, there is no 
automatic upgrade available.  Do not uninstall your current version, as 
you will need to export all abstracts out of your current version of Abstract 
Plus and import them into your newly-installed Abstract Plus version 3.1. 

Launching Abstract Plus  
Once installed, you can launch Abstract Plus: 

1.	 From the Start menu, select All Programs, Registry Plus, Abstract Plus, and then 
Abstract Plus 3.1. 

Version 2.0 February 2011 4 
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User Support 
For technical support via e-mail, contact cancerinfo@cdc.gov. 

The CDC Registry Plus Development group is funded primarily to support NPCR-funded 
state central cancer registries.  As a result, CDC helps state central cancer registries set up the 
software and perform basic customizations. CDC also provides periodic software updates and 
problem-solving to the extent of available resources. CDC does not provide on-site services, 
and does not support hospitals, clinics, laboratories, or other private users. 

Abstract Plus is intended for redistribution to cancer reporters after customization by the 
central registry. The state central registry or other institution redistributing Registry Plus 
software should provide all support to end users.  

State registry contact information can be found at the National Program of Cancer Registries 
Web site:  http://apps.nccd.cdc.gov/cancercontacts/npcr/contactlist.asp. 

Other users of Abstract Plus will need to independently understand and maintain the software 
application. 

Version 2.0 February 2011 5 
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Chapter 2: Abstract Plus General User Basics 
Learning Objectives 
In this chapter, you will learn to: 

	 Create your own user account upon initial access to the program 

	 How to address first-time log in and routine log in to Abstract Plus as an
 
Abstractor/general user 


	 Familiarize yourself with the Abstract Plus main window and identify Abstract Plus 
abstracting menu options 

	 Change your general user password 

	 Reset your password if forgotten, by answering your security challenge questions 

	 Update your security challenge questions and answers after initial set up 

	 Exit Abstract Plus and use the Backup option 

	 Use the Restore option to restore your abstracts database if corrupted 

Overview 
This chapter covers the basics of logging in to and out of Abstract Plus. It includes a 
description of the process by which a user account is generated, how to log into Abstract Plus 
for the first time and how to address the security challenge questions presented upon initial 
log in, how to log in to Abstract Plus routinely using a user ID and password, how to 
maintain your general user password, how to exit the application and use the Backup feature, 
and how to use the Restore feature to restore a corrupted abstracts database. 

Logging In 
After installing Abstract Plus version 3.1, upon initial launch of the program, you will be 
prompted to create a new user account. You will then need to log in using the new login 
information you entered along with an initial password of Welcome1, change your password, 
and then answer security or ―challenge‖ questions. Your answers to these questions will be 
used to validate your identity if you forget your Abstract Plus password---if you forget your 
password, Abstract Plus will ask you for the answers you provided to these security questions 
and then allow you to reset your password if the questions are answered correctly. 

The creation of a user account is enabled for the general user only upon initial launch of the 
program.  If other users already exist in your Abstract Plus application (i.e. the program has 
already been launched and user account(s) created), you will need to contact your 
Administrator to create a user account for you.  

When logged in with your own user ID and password, you are recorded as the abstractor 
when conducting either general abstracting or auditing tasks (unless your Administrator has 
modified this system option). This information can be used as selection criteria for reports 
and exports, and can also be used for general tracking purposes to associate abstractors with 
their specific abstracts, and auditors with the audits that they have conducted. 

Version 2.0 February 2011 6 
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Creating a User Account upon Initial Access and First-Time Log In 
After installing Abstract Plus version 3.1, if you are the first person to launch the program, 
you will be prompted to create a new user account. You will then be prompted to log in to 
Abstract Plus using your newly-created User ID and an initial password of Welcome1. 

If other users already exist in your Abstract Plus application (i.e. the 
program has already been launched and user account(s) created), you will 
need to contact your Administrator to create a user account for you and 
obtain your User ID. 

To create a new user account upon initial launch of the program, and log in to the application 
for the first time complete these steps: 

1.	 To launch the program, from the Start menu, select All Programs, Registry Plus, 
Abstract Plus, and then Abstract Plus 3.1. 

Result: The Create Users window opens. 

If your Administrator has already provided you with a User ID, go directly 
to step 7. 

2. 	 Enter  your full  name in the  User Name  field.  The format for name entry is last name, and  
then first name  and middle initial, e.g., Smith, John A.  In the example shown, the  user 
name being entered  has the last name USER, first name NEW, and middle initial A.  

Version 2.0 February 2011 7 
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3. 	 Enter a  User  ID  in the  User ID  field. User IDs can  only be characters, and  are 5-10  
characters in length. In the  future, you will enter  your User ID when logging in to  
Abstract Plus. In the example shown, the User ID being entered is NUSER.  

4. 	 Enter  your initials in the  Initials  field. Your initials will be displayed on the  main  
Abstract Plus window to  indicate when you are logged in to the application, and  may  be  
automatically  recorded  in the Abstracted By  field  when abstracting abstracts or 
conducting audits  if this application  preference is enabled  by  your Abstract Plus 
Administrator. This information is recorded in  order to  associate abstractors with the  
abstracts they have  generated, and auditors with the audits that they have  conducted.  In  
the example shown, the initials entered are NAU.  

Version 2.0 February 2011 8 
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5.  Click  Add.
  

Result:  The system adds the  new user account  to the  users list. 
 

6.  Click  Close.
  

Result:  The  Login  window opens. 
 

Version 2.0 February 2011 9 
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7.  Enter  your User ID  in the  User ID  field.  In the example shown, the User ID of NUSER 
is being entered.  

8.  Enter  the default initial password of  Welcome1  in the  Password  field.   

Welcome1 

When entering  your password, asterisks will be displayed rather than  your 
password  for added security. Note that passwords are case sensitive.  

9. Click OK. 
Result: A Password Update message is issued that lets you know you need to change 
your password.  This occurs upon initial log in only.  When changing your password, you 
must change it to a password that meets the password requirements set by your Abstract 
Plus Administrator. 

Version 2.0 February 2011 10 
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10. Click OK. 
Result: The Change User’s Password window opens, displaying your User ID and Old 
Password (which is Welcome1 at this point). 

11. Enter a new password in both the New Password and Confirm Password boxes, and 
click OK. You must type the same new password in both boxes. 

If  your Administrator has m ade no changes, by default, your new password  
must be between 8 and  20 characters, contain at least one  digit and  one  
alphabetical character, and must not contain any special characters.  

Result: The Define User’s Security Questions window opens, with your User ID 
displayed. 

Version 2.0 February 2011 11 
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To complete your initial log in to Abstract Plus, you are required to select the specified 
number of security questions and answer them.  The number of questions you will need 
to select and answer will depend on the number of security questions specified by your 
Abstract Plus Administrator when setting up Abstract Plus. Your answers to these 
questions will be used to validate your identity if you forget your general user Abstract 
Plus password.  If you forget your password, Abstract Plus will ask you for the answers 
you provided to your chosen security questions, and then allow you to reset your 
password if the questions are answered correctly. If you forget both your password and 
your answers to your selected security questions, you will need to have your Abstract 
Plus Administrator reset your password. 

12. Select a question from the first drop-down list and enter your answer in the box below 
the question.  

Version 2.0 February 2011 12 
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13. Continue selecting questions and answering them until each question is answered.  

14. Once all questions are selected and answers entered, click Submit Questions. 
Result: The Abstract Plus main window opens, with you logged in as a general user. 
Note that your User ID is displayed at the bottom of the window. 

Version 2.0 February 2011 13 
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Routine Log In 
After installation and initial log in to Abstract Plus, you will have a User ID and password for 
routine log in to your Abstract Plus general user account.  

For routine log in to Abstract Plus, complete these  steps:  

1. 	 To launch  the program, from the Start menu, select All Programs, Registry Plus, 
Abstract Plus, and then  Abstract Plus 3.1.  

Result: The  Login  window opens.  

2.  Enter  your User ID  in the  User ID  box. In  the example shown, the User ID being entered  
is NUSER.  

Version 2.0 February 2011 14 
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3.  Enter  your password  in the  Password  box, and Click  OK.  

When entering your password, asterisks will be displayed rather than your 
password for added security. Note that passwords are case sensitive. 

Result: The Abstract Plus main window opens, with you logged in as a general user. 
Note that your User ID is displayed at the bottom of the window. 

Version 2.0 February 2011 15 
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Activity 1 – Logging in to Abstract Plus 

Using what you have just learned, launch Abstract Plus and log in to the application. 

If you have not yet accessed the program, see page 7 of this manual or click here for 
instructions for initial login to the program.  

If your Administrator has already set up a user account for you and provided you with a User 
ID, see page 14 of this manual or click here for instructions regarding routine login. 

The Abstract Plus Main Window 
The Abstract Plus main window provides access to all of the application’s features.  Your 
User ID is displayed at the bottom of the window, and important system messages are 
displayed in the lower left-hand corner of the window.  The default edit set is displayed in the 
upper right-hand corner of the window. When logged in as an Abstractor, you will 
automatically have access to all of the application’s abstracting features via the main menu 
items. Some menu options are also available as buttons in the toolbar as shown below. 
Access to Administrator and Auditor functions require entry of special passwords. 

By default,  Microsoft  comes with sound effect features. One  of those 
features is a ―beep‖ feedback sound in response to  pressing the tab  or 
enter, etc. keys. If  you do  not like these sounds being issued as you  use 

Version 2.0 February 2011 16 
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Abstract Plus, you can turn them off by going to StartControl 
PanelSoundSounds Tabselect Default Beepselect None from the 
Sounds pull-down menuClick OK. 

The File Menu 
The File menu is used to access the majority of features that are used to work with abstracts.  
To access the File menu items, click on the File menu item, and select the desired sub-option, 
or use the appropriate keystroke combination for the desired sub-option. 

The following table describes the Abstract Plus File menu sub-options: 

Sub-option  (Keystroke)  Toolbar  Function  

Version 2.0 February 2011 17 



   

                                                                                                       

 

     

 
     

        

     

      

     

  
    

 

    

  
     

 

 
  

     

 

     
  

      
  

  
      

 
      

   
 

Abstract Plus Abstractor Training Manual Abstract Plus General User Basics 

Icon 

New Abstract (Ctrl+N) Create a new abstract 

Open/Find Abstract… 
(Ctrl+O) Search for and open an existing abstract 

Copy Abstract… (Ctrl+I) Copy an open abstract 

Close Abstract (Alt+C) Close an open abstract 

Save Abstract… (Ctrl+S) Save entered information 

Export Abstracts… (Ctrl+M) Export abstracts out of the Abstract Plus 
database into a NAACCR-formatted file 

Import Abstracts in NAACCR 
Format… (Ctrl+L) 

Import abstracts in a NAACCR-
formatted file into the Abstract Plus 
database 

Print Current Abstract (Ctrl+P) Preview the displayed abstract and/or 
print it 

Print Range of Abstracts… 
(Ctrl+R) 

Select and print a range of abstracts or 
save in a file 

Backup Abstract Database 
(Ctrl+B) 

Create backup database to be used by 
Restore feature if database becomes 
corrupted 

Restore… (Ctrl+Y) Restore/replace corrupted database with 
a previously saved backup database 

Exit (Alt+F4) Log off Abstract Plus with an option to 
back up the database with your work 

The Administration Menu 
The Administration menu is used to access the administrative features of the program, such 
as managing user accounts and setting up the application for abstraction and auditing.  No 
toolbar icons are available for any Administration menu options.  To access the 
Administration menu items, click on the Administration menu item, and select the desired 
sub-option, or use the appropriate keystroke combination for the desired sub-option. 
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Entry of a special Administrator password is required in order to access 
the Administration menu items; the application will prompt you for the 
Administrator password when you attempt to access any of the 
Administration menu items. Please see the Abstract Plus Training 
Manual for Administrators for more information regarding Abstract 
Plus Administrator functions. 

The following table describes the Abstract Plus Administration menu sub-options: 

Sub-option (Keystroke) Function 

Administrator Login/Modify Password 
(Ctrl+A) 

Log in as Administrator or change the 
Administrator password 

Create/Modify Users (Ctrl+U) Add, edit, or delete a user account or 
reset a password 

Application Preferences (Ctrl+E) Maintain all general, security, database 
and report application settings  

Manage Abstracting Display Types 
(Ctrl+D) 

Create, edit, or delete display types 
available for the abstracting features 

Manage Audit Display Types (Ctrl+F) 
Create, edit, or delete display types 
available for the auditing features 
(currently disabled) 

Manage Audit Look-ups (Ctrl+G) Maintain special audit lookup tables 
(currently disabled) 

Manage Audit Databases (Ctrl+H) Create, edit, or delete audit databases 
(currently disabled) 

The Auditor Menu 
The Auditor menu is used to access all of the available auditing features, such as opening and 
closing audits, and performing casefinding, reabstraction, and recoding audits. No toolbar 
icons are available for any Auditor menu options.  To access the Auditor menu items, click 
on the Auditor menu item, and select the desired sub-option, or use the appropriate 
keystroke combination for the desired sub-option. 
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Entry of a special Auditor password is required in order to access the Auditor 
menu items; the application will prompt you for the Auditor password when you 
initially access any of the Auditor menu items.  Note: If the Administrator 
password has already been entered, entry of the Auditor password is not 
required; Administrators automatically have access to all auditing features. 

Please note that due to development priorities, Abstract Plus version 3.1 is being 
released without the Auditor features; description of Auditor features provided in this 
manual is for informational purposes only. The Auditor features of Abstract Plus will 
be released in a future version of the program. 
The following table describes the Abstract Plus Auditor menu sub-options: 

Sub-option (Keystroke) Function 

Auditor Login/Modify Password 
(Ctrl+Shift+A) 

Login as Auditor, and/or modify 
Auditor password 

Perform Casefinding (Ctrl+Shift+F) Perform a casefinding audit on opened 
audit 

Run Casefinding Reports Run casefinding audit pre-reconciliation 
and final reports 

Export Non-match Abstracts 
(Ctrl+Shift+E) 

Export unreported tumors found upon 
casefinding audit in NAACCR file 
format 

Perform Reabstracting (Ctrl+Shift+R) Perform a reabstracting audit on opened 
audit 

Run Reabstracting Reports Run reabstraction audit pre-
reconciliation and final reports 

Export Reabstraction Audit 
(Ctrl+Shift+S) 

Export text file with reabstracting audit 
data for further analysis 

Perform Recoding (Ctrl+Shift+T) Perform a recoding audit on opened 
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audit 

Run Recoding Reports Run recoding audit pre-reconciliation 
and final reports 

Export Recoding Audit (Ctrl+Shift+U) Export text file with recoding audit data 
for further analysis 

Close Audit (Ctrl+Shift+C) Close the audit 

The Utilities Menu 
The Utilities menu is used to access a few supplementary functions included in the program, 
such as re-running edits in batch mode, querying your local database of doctors, managing 
facility and doctor codes, and deleting abstracts.  

To access the Utilities menu items, click on the Utilities menu item, and select the desired 
sub-option, or use the appropriate keystroke combination for the desired sub-option. 

The following table describes the Abstract Plus Utilities menu sub-options: 

Sub-option (Keystroke) Toolbar 
Icon Function 

Doctor Query System 
(Alt+Q) 

Query and search the doctor database; 
DQS can be accessed whether or not an 
abstract is opened, or a physician field 
selected 

Manage Facility Codes… 
Import (can use Alt+I keystroke) or edit 
(can use Alt+J keystroke) local facility 
codes 

Manage Doctor Codes… 
Import (can use Alt+K keystroke) or edit 
(can use Alt+L keystroke) local physician 
codes 

Delete Abstract(s) (Alt+P) Delete selected abstracts 

Notepad (Alt+N) Launch Notepad to view created text files 

The Reports Menu 
The Reports menu is used to access all of the available reports regarding abstracts in the 
Abstract Plus database.  No toolbar icons are available for any Reports menu options.  
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To access the Reports menu items, click on the Reports menu item, and select the desired 
report, or use the appropriate keystroke combination for the desired report. 

The following table describes the Abstract Plus Reports menu sub-options: 

Sub-option (Keystroke) Function 

Accession Register (Alt+Shift+A) 

Opens the Accession Register Report, which 
includes a line listing of all abstracts in the 
database, sorted by reporting hospital and 
accession number 

Patient Index (Alt+Shift+P) 
Opens the Patient Index Report, which includes a 
line listing of all abstracts in the database, sorted 
alphabetically by name 

Selected Cases (Alt+Shift+S) Opens a line listing report which includes 
abstracts based on user-specified criteria 

Status Report (Count of Cases) 
Summary… (Alt+Shift+T) 

Opens a report that includes the total number of 
complete and incomplete abstracts by export 
status within a user-specified date range 

Completion Status of Abstracts by 
month (Alt+Shift+C) 

Opens a report that includes abstract completion 
status by year and month of Date of Adm/1st 

Contact within a user-specified date range 

Report Wizard (Alt+Shift+W) Newly-added feature to enable users to generate 
their own custom reports (currently disabled) 

Edit Custom Reports 
(Alt_Shift+E) 

Edit an existing custom report (currently 
disabled) 

Run Custom Reports 
(Alt+Shift+R) 

Runs selected custom reports that have been 
added to the application using the Report Wizard 

Report Generator Help 
Opens online help for the Report Wizard; 
optional installation by Administrator required 
(currently disabled) 
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The Options Menu 
For security purposes, users may want to change their passwords and security questions on a 
routine basis.  The Options menu is used to update the user’s security questions or change 
their password.  No toolbar icons are available for any Options menu selections.  

To access the Options menu items, click on the Options menu item, and select the desired 
sub-option, or use the appropriate keystroke combination for the desired sub-option. 

The following table describes the Abstract Plus Options menu sub-options: 

Sub-option (Keystroke) Function 

Update Security Questions 
(Ctrl+Q) 

Opens the Update User’s Security Questions 
window with the current User ID displayed along 
with the current security questions and answers 
specified by the user; new answers to existing 
questions may be entered, as well as new 
questions and answers 

Change Password (Ctrl+Shift+P) 

Opens Change User’s Password window, where 
the user can enter their current password, and a 
new password in both New Password and 
Confirm Password in order to change their 
password 

For more information regarding updating personal security questions, see  
page  32  of this manual or click  here. For more information regarding  
changing  your general user password, see page  26  of this manual or click  
here.  

The Help Menu 
The Help menu is used to access the online help that is available within the program.  To 
access the Help menu items, click on the Help menu item, and select the desired sub-option, 
or use the appropriate keystroke combination for the desired sub-option. 

The following table describes the Abstract Plus Help menu sub-options: 

Sub-option 
(Keystroke) 

Toolbar 
Icon Function 
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Contents… (Ctrl+F1) View the contents of Abstract Plus online Help 

Search for help on… (F1) Enter search terms for topics on which you need 
more information 

About (F10) View Abstract Plus, Collaborative Staging, and 
Edits metafile version information 

Run SEER 
Hematopoietic Database 

Launch the SEER Hematopoietic Database 
stand-alone application to help you code 
hematopoietic and lymphoid neoplasms cases 
diagnosed beginning January 1, 2010 

New Abstract Plus Abstracting and Editing Features 
One of the primary activities that Abstract Plus is used for is the abstraction of information 
from medical records. As mentioned, Abstract Plus version 3.1 has been entirely 
reprogrammed using .NET technology, and has a new, extremely user-friendly abstracting 
interface.  New direct grid entry of coded values and quick select options for pull-down 
menus allow for an easy, streamlined abstracting experience, as well as easier viewing of text 
fields, online help, and edit errors. 

The Abstract Plus Abstracting Process 
The basic process of generating and updating an abstract is as follows: 

i.	 Create the abstract with the patient’s identifiers, such as name and social security 
number and save. After you create an abstract, you can save it at any time and return to 
your work at a later time. 

ii.	 Enter codes and text in the data entry fields. Save the abstract to retain the information 
you have entered. 

iii.	 Correct errors. Each time you open or save the abstract, Abstract Plus can automatically 
edit the entered information for accuracy and completeness using the edit set and 
required fields chosen by your Abstract Plus Administrator. 

iv.	 After you have entered all your data and corrected all errors, the system saves your new 
abstract as complete.  You will see the edits error count and completion status 
indicators at the bottom of the abstracting window turn from red to green, indicating 
that the abstract is complete. 

The Abstract Plus Abstracting Window 
The Abstract Plus Abstracting window is divided into 2 main sections: a data entry grid for 
coded values on the left, and a data entry grid for text fields on the right.  When you left-click 
and hold your mouse on the vertical divider bar in the center of the window, a splitter is 
highlighted which you can drag to the left or right to resize the view of codes or text fields, 
and the application remembers your last placement of the divider bar. You can vertically 
scroll the view of coded values and text fields independently to easily and concurrently view 
codes and associated text. 
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Custom 
Data 
Item 
Labels 

Edit Error 
Count 

Easy, Direct 
Access to Text 
Fields 

Can Resize 
Panes 

Right-click Any 
Field for Help 
and Edit Errors 

Direct 
Grid 
Entry 

Section 
Headers 

Completion 
Status 

The Abstract Plus version 3.1 user-friendly abstracting interface includes all new 
abstracting features.  Please see page 47 of this training manual, or click here for more 
information regarding Abstract Plus abstracting features. 

The abstracting interface is called a display type. A display type basically includes 
information regarding the fields displayed/collected, critical (or required) fields, edit set 
selections, and collaborative staging preferences, and is configured by your Abstract Plus 
Administrator upon setup of the application. The data items in a display type are labeled 
and ordered by your Administrator, as well as grouped into logical sections, which also 
have customizable labels. 

Regardless of the customized label a data item may have, when a data item is 
selected, the associated NAACCR item name is always displayed in the lower 
left-hand corner of the window.  This information is helpful when looking up 
information regarding a data item in the online help reference books. 
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New Data Quality Edits and Error Resolution Features 

Each time an abstract is opened or saved, Abstract Plus automatically edits the entered 
information for accuracy and completeness using the edit set and required fields chosen by 
your Abstract Plus Administrator.  

You must resolve all edit errors and fill in all critical (required) 
fields in order to complete the abstract. 

Abstract Plus version 3.1 has all-new edit error display features that greatly facilitate the 
error resolution process.  Editing features include display of the name of the edit set being 
run at the top of the abstracting window and an all-new Edit Set Results window. Please see 
page 61 of this training manual, or click here for more information regarding Abstract Plus 
editing features. 

Changing Your General User Password 
For security purposes, you may be prompted to change your general user password 
periodically, based on the Password Policy specified by your Abstract Plus Administrator.  
Your Administrator specifies your password requirements, how often you need to change 
your password, as well as how many of your last passwords you cannot repeat. 
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To change your Abstractor/general user password, complete these steps: 

1.  Open  the  Change User’s  Password  window.  This may be done in  2 ways:  

a.  From  Options Menu, select Change Password.   

b.  When logging in to  Abstract Plus, enter  your User ID, tab  or click into  the  
Password  box, and then  click  Change Password  on the Login window.   

Result: The Change User’s Password window opens, with your User ID displayed. 

2.  Enter  your Current Password  in  Old Password  box.  

3.  Enter a  New Password  in  New Password  box  that  meets the password requirements 
specified by  your Abstract Plus Administrator.    
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If your Administrator has made no changes, by default, your new password 
must be between 8 and 20 characters, contain at least one digit and one 
alphabetical character, and must not contain any special characters. 

4. Re-enter your New Password in the Confirm Password box. 

5. 	 Click  OK  to  change  your password.  

Result: Your password is changed, and the Abstract Plus main window is opened. 

Possible Errors when Changing Your Password 
There are three possible errors you may receive when attempting to change your password: 

1. 	 Old  password is incorrect. Yo u must correctly enter  your old  password in  order to  
successfully change it.  Click  OK, and then correctly re-enter  your old  password.  

2. 	 New  passwords do  not match.   The new password entered into the  New  Password  and  
Confirm  Password  boxes must match exactly.  Click  OK, and then correctly re-enter  
your new password in the New  and  Confirm password boxes.  
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3. 	 New password does not meet specified password requirements. Your new password  
must meet the password requirements specified by  your Abstract Plus Administrator.  
Click  OK, and  then re-enter a new password that meets the stated  password  
requirements.  

Resetting a Forgotten Password 
In the event that you should forget your password, Abstract Plus version 3.1 has a security 
challenge question feature that will allow you to reset your own password without having to 
contact your Administrator. The security challenge question feature enables you to securely 
reset your password by answering a specified number of the security questions that you 
selected and answered upon initial login to Abstract Plus.  

Your answers to these questions are used to validate your identity; Abstract Plus will ask you 
for the answers you provided to your chosen security questions, and then allow you to reset 
your password if the questions are answered correctly.  If you forget both your password and 
your answers to your security questions, you will need to have your Abstract Plus 
Administrator reset your password. 

To reset your password if you have forgotten it, complete these steps: 
1. 	 When logging in to Abstract Plus, enter  your User ID, tab  or click into  the  Password box, 

and then click  Forgot Password  on the Login window.   
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Result:  The  Reset User’s Password  window opens, with your User ID displayed, as 
well as the number of security questions specified by  your Administrator upon set up  of  
Abstract Plus.  

2.  Enter the answer to each displayed question with the same answer you provided  upon  
initial login to Abstract Plus.  

3.  Click  Validate  Questions  once all questions are answered.
  

Result:  The  Reset User’s Password  window opens, with your User ID displayed. 
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4.  Enter a  New Password  in  both  the  New  and  Confirm  password  boxes, and then  click  
Reset Password.  

Result: The Forgot Password window opens, with your User ID displayed. 
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5. Enter your New Password in Password box, and click OK. 

Result: The Abstract Plus main window opens, with you logged in as a general user. 
Your password has been successfully set to the new password you have specified. 

Updating Personal Security Questions 
Once you are logged in to Abstract Plus, you can update your selected security questions 
and/or answers at any point. For example, if you selected the security question of ―How 
many children do you have?‖ and you just had a new child enter your family, you can update 
your answer to this question.  

To update your security questions and/or answers, complete these steps: 

1. From Options Menu, select Update Security Questions. 

Result: The Update User’s Security Questions window opens, with your User ID 
displayed, as well as the current security questions and answers which you have 
specified. For added security asterisks are displayed rather than your answers to the 
questions. 
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2. You can select new questions and answer them or supply new answers to your previously 
selected questions. When you have completed your changes, click Submit Questions. 

Result: You are returned to the Abstract Plus main window with your changes saved for 
future use. 
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Exiting Abstract Plus and Using the Backup Option 
When logging off and exiting Abstract Plus, the application will prompt you to back up the 
current abstract database. 

To log off / exit Abstract Plus and use the database backup option, complete these steps: 

1. Exit Abstract Plus.  This can be done in 3 ways: 

a.  Click on  the  File  menu, and  select Exit.  

b.  Use the keystroke  Alt+F4.   
c.  Click the  X in upper right corner of screen.  

Result: The Exit Program window opens, and asks if you are sure you want to exit the 
program. 

2. Click Yes. 

Result: The Backup Database window opens, and asks if you would like to backup your 
Abstract Plus abstracts database (ABSPLUS.MDB). 
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Although you can choose not to backup your database, it is highly 
recommended that you backup your database after finishing an 
abstracting session during which changes were made (abstracts were 
added, updated, or deleted). Note that the Backup and Restore Database 
menu options are not available when using SQL Server database. 

3.  Click  Yes. 
 
Result:   The  Abstract Plus Database Backup  window opens  with  defaults set.
  

4. 	 To change the  default  path, navigate to and identify the location  on your computer or 

network  where  you would like to save  your backup file  by  clicking  the  Folder  icon  .  

Result:   The  Browse for Folder  window opens.  

Version 2.0 February 2011 35 



   

                                                                                                       

 

   

 

 
 

 

     
      

 

    
   

 

Abstract Plus Abstractor Training Manual Abstract Plus General User Basics 

The default location for saving backup files is
  
C:\RegPlus\AbstractPlus\MDBS\Backup.  You may navigate to a different 

location if  you so choose.
  

5. To accept the default location for saving the backup, click OK.
 

6.  Select the desired  compression le vel  for the  zip file if other than the  default.   

7.  Enter a  password  (optional)  to encrypt the zip file.  Click  Save  to create the  backup and  
exit or click  Close  to exit the application without saving the backup file.  

If you choose to password-protect your backup file, the encrypted zip 
file cannot be restored without the specified password. It is very 
important that you remember this password! 

Result: The backup is saved in the zip file, and a confirmation window opens. A 
progress bar is also displayed at the bottom of the screen. 
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A progress bar is also displayed at the bottom of the screen. 

8. 	 Click  OK.  
Result:  The Abstract Plus application  closes.  

Using the Restore Option 
In the event that your Abstract Plus abstracts database (ABSPLUS.MDB) is corrupted, if you 
have used the Backup option to backup your database you will be able to restore your 
database using the Restore option. The Restore option allows you to go back to a file that 
you saved with the same Abstract Plus version on a date when you encountered no problems. 
This is why it is so strongly recommended that you back up your work when exiting the 
application. 

To use the Restore option to restore your Abstract Plus abstract database to an earlier saved 
backup, complete these steps: 

1.	 Open the Restore Database window.  This can be done in 2 ways: 

a.	 Click on the File menu, and select Restore. 

b.  Use the keystroke  Ctrl+Y. 
 

Result: The  Restore Abstract Plus Database  window opens. 
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2. Navigate to and identify the zipped backup file on your computer or network by clicking 

the Folder icon

Result: The Select the file you want to restore window opens with a list of backup files 
displayed. 

The default location for saving backup files is  
C:\RegPlus\AbstractPlus\MDBS\Backup. You may need to  navigate to a  
different location if  you saved  your backup file in  a location  other than the  
default location.  

3. 	 Select the backup file to  which you wish to  restore  your Abstract Plus abstract database, 
and click  Open.  

Result:   You are returned to the  Restore Abstract Plus Database  window, with the  
selected backup file displayed.  
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4.  If  you password  protected the selected  backup file, enter the  password in  the password  
box, and click  Restore.  

Result: The Abstract Plus main window opens, with the selected abstracts backup 
database restored. You may now resume abstracting activities. 
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Questions 
Answer these questions about Abstract Plus General User Basics (the answers are in 
Appendix A, on page 124): 

1.	 What are the first things you need to do upon initial login into Abstract Plus? 

2.	 What is the point of the security challenge questions in Abstract Plus? 

3.	 Why is it important that you have your own user ID and password? 

4.	 When logging off Abstract Plus, how can you ensure that the work you did during the 
session is secure and safe? 
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Chapter  3:  Working  with Abstracts  
Learning Objectives 
In this chapter, you will learn to: 

 Import abstracts into Abstract Plus 

 Identify the areas in the Abstract Plus abstracting screen 

 Create a new abstract 

  Modify an abstract, including entering text, coding histologic type, and coding and  
deriving Collaborative Staging  fields
  

  Correct errors in an abstract
  

  Copy an abstract
  

  Export abstracts
  

  Print a range of  abstracts
  

 Use the  Utility  functions  (Utilities)  
 

  Use the Help  functions to find  out more information about fields
  

Overview 
This chapter covers the basics about abstracting and working with abstracts in Abstract Plus 
version 3.1. It includes a description of the process by which abstracts are generated, 
modified, edited, and completed, as well as how to print and copy existing abstracts and how 
to import and export abstracts in NACCR file format. 

You can start working with abstracts by 

 Importing abstracts in NAACCR format 

 Creating a new abstract 

 Searching for and opening an existing abstract 

 Copying an existing abstract and saving it as a new one 
An existing abstract can be modified and the changes saved. Abstracts can also be exported 
in NAACCR format to any other system. 

Importing Abstracts 
You can import abstracts in NAACCR format from any system into Abstract Plus.  Both 
complete and incomplete abstracts can be imported, as long as the information is in 
NAACCR file format. 

To import an abstracts or file of abstracts in NAACCR file format, complete these steps: 

1. Open the Import Abstracts window. This can be done in 3 ways: 

a.  Click on  the  File  menu, and  select Import Abstracts in NAACCR Format.  
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b.  Click the Import icon  on  the tool bar . 
c.  Use the keystroke  Ctrl+L.  

Result: The Import Abstracts in NAACCR Format window opens.  

The Import Abstracts function allows you to import NAACCR-format Version  11.x or 
12.x  abstract records of  NAACCR Record  Types I, C, A, or M.  Any records in  
NAACCR  version  11.x will be converted to the latest NAACCR version  prior to  
importing (e.g., NAACCR version  12.0), and Collaborative Staging  will be re-derived.  
The import function also  performs a basic structural check  for record size and version  
number before importing the abstracts. The system  will verify that the file contains valid  
NAACCR records and will  display  a record count and  other information about the file.  
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2.  Click  Select File  to  navigate to the file to be imported  on  your computer  or network.  

Working with Abstracts Abstract Plus Abstractor Training Manual 

The Import Abstracts window includes these fields and options: 

Field/Option Description 

Import File The name and location of the file of abstracts in NAACCR 
file format to be imported (click Select File to identify file 
for import) 

Total Abstracts The total number of abstracts included in the file to be 
imported 

Importing Abstract No. While importing, this field displays the sequential number of 
the abstract currently being imported 

Total Abstracts Imported While importing and upon completion of import, this field 
displays the total number of abstracts imported 

Layout Version The NAACCR Record Version [item #50 ]of the file to be 
imported 

NAACCR Abstract Type The NAACCR Record Type [item # 10] of the abstracts in 
the file to be imported 

File contains CrLf The import file may or may not contain Carriage Return, 
Line Feed characters after each abstract; this field informs 
you as to whether it does or not 

Use Incoming File’s 
Export Status 

Option to use the export status included in the import file; 
when checked, Abstract Plus will check the field of Date 
Case Report Exported [item #2110]---if the Date Case 
Report Exported is filled, the incoming abstract will be 
marked as exported within Abstract Plus 3.1 

Check Abstracts’ 
completed Status for 
import 

Option to set the Completion Status of the imported abstracts 
to Complete or Incomplete 

Result:   The  Select File  window  opens  defaulted  to the 
 
C:\RegPlus\AbstractPlus\Imports  folder.   
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3. 	 Select the file  of abstracts in NAACCR  file  format that you would like to import, and  
click  Open. In the example shown, the file being selected and imported  is named  
v12Data.dat.  

Result:   You are returned to the Import Abstracts window, where preliminary  
information is displayed about the file selected for import, such as the  number of  
abstracts in  the file  and  the NAACCR abstract type. In  the example shown, the  
V12Data.dat  file includes 17 abstracts of Record  Type  A in NAACCR Record  Version  
12.0 (120), and contains Carriage Return and  or Line Feed characters after each abstract.  

4.	 Specify the Completion Status (complete or incomplete) that you would like to assign to 
all abstracts in the imported file. Click Import. In the example shown, the default option 
of Incomplete is being selected. 
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Result:   The abstracts in  the import file are imported into Abstract Plus.  When the  
import is complete, the application lets you know by stating ―Import Complete…‖ on the  
status bar in the lower left-hand corner of the window.  

Notice the Import Log button on this window. Clicking Import Log opens the Import 
Log window, where you can view the history of the abstracts imports. 

5. 	 Click  Import  Log.  

Result: The  Import Log window opens.  

6.  Enter  either a desired export date  range  or  click  Find All.    
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Result: The  system displays information about the data that has been imported: the  date 
the file  was imported, the number of abstracts in the  file, the number of abstracts 
imported, the  name of the abstractor that imported the abstracts, and the imported file  
name.  

7.  Click  Close  to close the Import Log, and  Close  again to close the Import window.  

Activity 2 – Importing Abstracts 

Using what you have just learned, import a file of abstracts in NAACCR file format into 
Abstract Plus.  You can import a file of your own, or any of the sample data files in the 
Abstract Plus Imports folder. 

Please see page 41 of this training manual or click here for more information about importing 
abstracts into Abstract Plus. 

Creating a New Abstract 
To create a new abstract, complete these steps: 

1. Open the Abstract Plus Abstracting window. This can be done in 3 ways: 

a.  Click on  the  File  menu, and  select New  Abstract.  

Version 2.0 February 2011 46 



     

     

 

 
   

     

   
    

     
    

   
 

   
   

    
 

  
        

 

Working with Abstracts Abstract Plus Abstractor Training Manual 

b.  Click the  New  icon  on the tool bar . 
c. Use the keystroke Ctrl+N. 

Result: The Abstract Plus Abstracting Window opens. 

The Abstract Plus Abstracting Window 
As mentioned, Abstract Plus version 3.1 has been entirely reprogrammed using .NET 
technology, and has a new, extremely user-friendly abstracting interface. New direct grid 
entry of coded values and quick select options for pull-down menus allow for an easy, 
streamlined abstracting experience, as well as easier viewing of text fields, online help, and 
edit errors. 

The Abstract Plus Abstracting window is divided into 2 main sections: a data entry grid for 
coded values on the left, and a data entry grid for text fields on the right.  When you left-click 
and hold your mouse on the vertical divider bar in the center of the window, a splitter is 
highlighted which you can drag to the left or right to resize the view of codes or text fields, 
and the application remembers your last placement of the divider bar. You can vertically 
scroll the view of coded values and text fields independently to easily and concurrently view 
codes and associated text. 
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Custom 
Data 
Item 
Labels 

Edit Error 
Count 

Easy, Direct 
Access to Text 
Fields 

Can Resize 
Panes 

Right-click Any 
Field for Help 
and Edit Errors 

Direct 
Grid 
Entry 

Section 
Headers 

Completion 
Status 

Recall that the basic process of generating and updating an abstract is as follows: 
i.  Create the abstract with the  patient’s identifiers, such as name  and social security  

number and save. After you create an abstract, you can save it at any time  and return  
to your work at a later time.  

ii.  Enter codes and  text in the in the  data entry  fields. Save the abstract to retain the  
information you  have entered.  

iii.  Correct errors. Each time  you  open  or save the abstract, Abstract Plus can  
automatically  edit the entered information for accuracy and completeness using the  
edit set and required fields chosen  by  your Abstract Plus Administrator.  

iv.  After you have entered all  your data and corrected all errors, the system saves your 
new abstract as complete.  You will see the edits  error count and completion status 
indicators at the bottom of the abstracting window turn from red to green, indicating  
that the abstract is complete.  

The Abstractor uses the following abstracting features of the abstracting window to 
enter information regarding the patient and tumor being abstracted: 

a.	 Many data items offer code selection from drop-down lists. In addition, the 
drop-down lists feature an auto-complete, find-as-you-type function that allows 
the user to type in the first letter, or first few letters, of the desired code label, and 
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the application auto-selects the first item in the list beginning with that letter.  In 
the example shown below, an A has been typed into the Race 1 field, and the 
application auto-selects the value of American Indian, Aleutian, or Eskimo: 

If you begin typing in the data item, but find you need to revise what 
you have typed, press the backspace key to delete what you have 
already entered and start typing again. This enables the find-as-you-
type feature to automatically find your revised entry. 

b.	 For data items with extensive listing of coded values, such as histology, there is 
lookup assisted data entry with an advanced search feature. You can either 
enter the code directly if known, or click on the magnifying glass icon to the left 
of the data item (or press F4) to use the search feature: 

Enter a full or partial search term or code to search for, and then double-click on 
the code of your choice to transfer the value to the data item in the data entry grid. 

c.	  Depending on the system preferences set by  your Abstract Plus Administrator, 
users can  automatically calculate Age at Diagnosis  once  date of birth and 
diagnosis are entered, and  can  calculate  Collaborative Staging  by clicking on  
the calculator icon  to the left of the data item:  
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d. 	 Prompt  messages  may be associated with each  data item,  so that when the  
abstractor clicks into the  field, a pop-up  box comes up with a message or 
instructions about abstracting that field:  

e.	  When entering text, a progress bar  is displayed below each text field indicating  
how  much space is left so that you can  properly prioritize the information  you are  
entering:  

f.  Keyboard  and  mouse  alternatives  are now available for every  function  in the  
software.  Note that Keystroke options are displayed  on menus for all menu items, 
and  Appendix B  of this training  manual contains a listing of standard Abstract 
Plus keyboard shortcuts to functions.  

g.  All-new  right-click functions  for individual data items, including access to field  
context help, edits error information, field messages, and a function to clear all  
Collaborative Stage  fields:  

h.	 Color-coded edits error count and abstract completion status information is 
clearly displayed to the user at the bottom of the abstracting window, and changes 
from red to green upon completion of the abstract: 
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Incomplete abstract containing edit errors: 

Complete abstract containing no edit errors: 

i. 	 Once saved, each abstract is assigned an  unique  Abstract Reference ID  (or 
AbsRefID), displayed in  the  upper left-hand corner of the data entry area of 
abstracting window, as well as in the title bar of the application along with the  
patient name:  

j. 	 Abstracts can  be  held to  prevent export. The  Held  check box allows an  
abstractor to  prevent a case  from being exported even if it is considered complete  
by the system.  This can be  used  if, for example, the abstractor is searching for 
additional information to be included  before the abstract is exported.   If checked, 
the abstract will not be exported, regardless of Completion  Status:  

Entering Dates in Abstract Plus 3.1 
As of the NAACCR version 12 record layout, all dates are in the YYYYMMDD format.  
Because the NAACCR standards are so tightly integrated with the Abstract Plus program, 
dates are entered in the YYYY/MM/DD format in Abstract Plus v3.1. 

The Abstractor will enter dates in the new YYYYMMDD format as follows: 

YYYYMMDD – when complete date is known and valid 

YYYYMM – when year and month are known and valid, and day is unknown 

YYYY – when year is known and valid, and month and day are unknown 

Blank – when no known date applies 

Abstract Plus 3.1 has a date field entry mask on all date fields that 
already has the slashes in it.  Although the application allows you to 
type the slashes and dashes when entering dates fields, you can save 
keystrokes by only typing the 8 characters of the date. For 
example for the date of August 1, 2010, the date can be entered as 
20100801. 
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Activity 3 – Creating a New Abstract and Abstracting Patient 
Information 

Using what you have just learned, create a new abstract.  Please see page 46 of this training 
manual or click here for more information about creating a new abstract. 

1. 	 Type  DOE  in the  Name--Last  field, and  press Enter. Notice that the next field is now  
highlighted.  

2.  Enter the following information in  the following fields:  

Field Value to be Entered 

Name--First JOHN 

Name--Middle M 

Name--Maiden Leave blank (press enter to move to next field) 

Name--Alias Leave blank (press enter to move to next field) 

Social Security Number 999-99-9999 

Addr at DX—No Street 123 EAST MAIN ST 

Addr at DX—Supplementl Leave blank (press enter to move to next field) 

Addr at DX--City ATLANTA 

3. 	 Click or tab into the  Addr at DX  State  field.  

Result: A list of states appears in the Select New  Value field.  
4. 	 Start typing  Georgia. Notice that the system displays the  full  name of the state in the  

even before  you finish typing. Press Enter.  

If you begin typing in the data item, but find you need to revise what 
you have typed, press the backspace key to delete what you have 
already entered, and start typing again. This enables the find-as-you-
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type feature to automatically  find your revised entry.  

5. 	 Type  999999999  in the  Addr  at DX—Postal Code  field, and  press Enter.  

6. 	 Click on  the  magnifying  glass icon to the left of the County at DX  field to  open the Code  
Lookup for County  at DX window.  

Result: The Code Lookup for County at DX window opens. 

7. 	 Enter DE in  the search box, and  double-click on the  087  value for Decatur County.  

Result: The  value of  087  is automatically entered into  the data entry  grid for the County  
at DX field, and the C ode Lookup for County at DX  window  automatically closes.  

8. 	 Enter the following information in  the following fields, either typing the value, using the  
drop-down list feature, or using the advanced search feature by clicking on the  
magnifying  glass icon where available:  

Field Value to be Entered 

Race 1 01 – White 

Race 2 88 – No further race documented 

Race 3 88 – No further race documented 

Race 4 88 – No further race documented 

Race 5 88 – No further race documented 

Spanish/Hispanic Origin 0 – Non-Spanish; non-Hispanic 

Date of Birth 1961/03/16 

Date of Birth Flag Leave blank (press enter to move to next field) 

Birthplace 000 – United States, NOS 

Version 2.0 February 2011 53 



    

                                                                                                       

  

   

  

  
 

 

  
 

    

   

        

    
 

    
 

   

    
    

    
 

  

   
  

    

    
 

 
 

 

 

Abstract Plus Abstractor Training Manual Working with Abstracts 

Field Value to be Entered 

Sex 1 – Male 

Text—Usual Occupation FARMER 

Text—Usual Industry FARMER/RANCHER 

Questions—Creating Abstracts 
Answer these questions about creating an abstract in Abstract Plus (the answers are in 
Appendix A, on page 124): 

1. What are the three ways that you can use to start working with abstracts? 

2. What are the two main areas of the Abstract Plus Abstracting window? 

Entering Information into Text Fields 
The NAACCR Volume II Data Dictionary defines text documentation as an essential 
component of a complete electronic abstract.  Text information is utilized for quality control 
and special studies, and is needed to justify coded values and to document supplemental 
information not transmitted within coded values. High-quality text documentation facilitates 
consolidation of information from multiple reporting sources at the central registry. 

The text field must contain a description that has been entered by the abstractor 
independently from the code(s). Information documenting the disease process and treatments 
provided should be entered manually from the medical record. It is best practice to abstract 
all available text information prior to entering codes for any of the coded cancer 
identification of treatment data items. 

In Abstract Plus, the various text fields are presented within the data entry grid on the right 
side of the Abstracting Window.  The order and names of the text fields that you see is 
specified by your Abstract Plus Administrator upon set up of the software. 

You can scroll up and down in the text entry grid separate from the data entry grid on the left, 
facilitating the concurrent viewing of text and codes.  Note that when entering text, a helpful 
progress bar is displayed below each text field that indicates how much space is left so that 
you can properly prioritize the information you are entering. 

Line returns are not allowed in Abstract Plus text fields. Pressing  Enter  
will move  the cursor to  the  next text field in  the text entry  grid.  
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Activity 4 – Entering Text Fields 

To practice entering text into the text area entry grid, enter the following information into the 
following text fields: 

Text Field Value to be Entered 

Physical Examination 02/15/2007: 45 yo white, non-Hispanic male 
presenting with prostate cancer. Retired farmer. 

X-ray/Scans (including Other 
Imaging Examination) 

None; no metastases 

Lab Tests 02/17/2007: PSA , elevated, 0.2 ng/ml 

OP/Surgical Procedures 02/23/2007: TURP, NOS 

Pathology Adenocarcinoma, NOS, grade 1 

Primary Site Title Prostate 

Histology Title (Type, 
Behavior, and Grade) 

Adenocarcinoma, in situ, grade I 

Staging Decisions 001 mm tumor, in situ, no lymph node 
involvement 

Activity 5 – Abstracting Cancer Information 

To practice entering information regarding cancer identification information about the tumor 
being reported, enter the following information into the following fields either by typing the 
value, using the drop-down list feature, or using the advanced search feature by clicking on 
the magnifying glass icon where available: 

Field Value to be Entered 

Date of Diagnosis 2007/02/23 

Date of Diagnosis Flag Leave blank (press enter to move to next field) 

Primary Site C619 (Prostate, NOS) 

Laterality 0 – Not a paired site 

Note: Upon entry of both the Date of Birth and Date of Diagnosis fields, The Age at 
Diagnosis (045) is automatically calculated and entered into the Age at Diagnosis field. 

Abstracting Histologic Type 
Prior to cases diagnosed in 2010, coding of Histologic Type in Abstract Plus entailed using 
the advanced search feature for the Histologic Type field:  click the magnifying glass icon to 
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the left of the field, enter a search term in the search window that opens, and double-click the 
histologic code that is listed for the specific term for which a search was conducted. 

However, new reportability instructions and data collection rules for hematopoietic and 
lymphoid neoplasms have gone into effect for cases diagnosed beginning January 1, 2010. 
As a result, two tools have been developed by SEER for use beginning in 2010: The 
Hematopoietic and Lymphoid Neoplasm Case Reportability and Coding Manual, and the 
Hematopoietic Database (DB).  The Hematopoietic and Lymphoid Neoplasm Case 
Reportability and Coding Manual comes with the Hematopoietic Database; contains 
reportability instructions and rules for determining the number of primaries, the primary site 
and histology, and grade.  

The Hematopoietic DB is a stand-alone application developed to assist in screening for 
reportable cases and determining reportability requirements, and contains abstracting and 
coding information for all hematopoietic and lymphoid neoplasms (9590/3-9992/3).  

The SEER Hematopoietic Database must be independently installed 
and maintained by the Abstractor.  It can be downloaded from the 
following URL: http://seer.cancer.gov/tools/heme/. In order to stay 
abreast of revisions in the database, it is recommended that you sign up 
on the website to receive e-mails when the database is updated: 

Once installed on the same computer on which Abstract Plus is installed, the Hematopoietic 
Database is minimally integrated into Abstract Plus, and can be launched in the following 3 
ways: 

i.	 From the Histology Lookup window: Click on the magnifying glass icon to the left of 
the Histologic Type ICD-O-3 data item (or press F4) to use the search feature: 

And then click the Hematopoietic Database blood drop icon to launch the database. 
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ii. Click on the Help menu, and select Run SEER Hematopoietic Database. 

iii. Click the Hematopoietic Database icon on the tool bar . 

Be sure to follow the steps in the flowchart in  Appendix C  when  
using Hematopoietic Database and Manual  to code  hematopoietic 
and lymphoid  neoplasms.  

Activity 6 – Abstracting Histologic Type 

To practice entering Histologic Type, complete these steps: 

1.	 Click the magnifying glass icon to the left of the Histologic Type ICD-O-3 field, and type 
Adenocarcinoma, NOS in the Search box. 

Result: The Code Lookup for Histologic Type ICD-O-3 window opens. 
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2. Type Adenocarcinoma in the search box, and double-click the 8140 code value to the 
left of the Adenocarcinoma in situ, NOS description. 
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Result: The value of 8140 is automatically entered into the data entry grid for the 
Histologic Type ICD-O-3 field, and the Code Lookup for Histologic Type ICD-O-3 
window automatically closes. 

In this activity, we are abstracting the histologic type for an 
Adenocarcinoma of the prostate.  If you are abstracting Histologic Type 
for a hematopoietic or lymphoid neoplasm, be sure to click the blood 

drop icon   to run  the SEER Hematopoietic Database.  

3.	 Complete the coding for the Cancer Identification section by entering the following 
information into the following fields either typing the value or using the drop-down list 
feature: 

Field Value to be Entered 

Behavior Code ICD-O-3 2 – Carcinoma in situ 

Grade 1 – Grade 1; well differentiated 

Diagnostic Confirmation 1 – Positive Histology 

Saving Abstracts 
Once you have entered information into an abstract, it is a good idea to save your work often.  
To save your work, complete these steps: 

1.	 Saving an abstract can be done in 3 ways: 

a.	  Click on  the  File  menu, and  select Save  Abstract.  

b. 	 Click the  Save  icon  on the tool bar
c.	 Use the keystroke Ctrl+S. 
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Results:  
  
1)  The  information entered  thus far for  the abstract is saved  to the database, and
   

2)  edits will run  (depending on the way  your Abstract Plus Administrator set up your 
Abstract Plus application).
   




3)  The  Edit Set Results window  opens  and  displays information about any edit errors the 
 
abstract may  contain. 
 

4) Once saved, each abstract is assigned an unique Abstract Reference ID (or 
AbsRefID), displayed in the upper left-hand corner of the data entry area of abstracting 
window, as well as in the title bar of the application along with the patient name: 
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5) The EDITS Error Count and Abstract Completion status indicators reflect the current 
edit error count and completion status of the abstract.  If there are  any errors within  the  
abstract, both  of these  indicators will display in red.  In the example shown, the abstract 
contains 35  edit errors and as a result, is deemed incomplete.   

Correcting Edit Errors 
For any abstract you can run edits and view edit errors by saving the abstract, clicking the 
EDITS button on the toolbar, or pressing F8. 

Each time an abstract is opened or saved Abstract Plus automatically edits the entered 
information for accuracy and completeness using the edit set and required fields chosen by 
your Abstract Plus Administrator.  

You must resolve all edit errors and fill in all critical (required) 
fields in order to complete the abstract. 

Abstract Plus version 3.1 has all-new edit error display features that greatly facilitate the 
error resolution process.  Editing features include: 

a.	  The  edit set  being run  on the abstract is clearly  displayed  at the top  of the abstracting  
window.  In the example shown, the edit set being applied is named  Central Vs 12  State  
Example  - Incoming Abstracts:  

b. 	 When edits are run, the  Edit Set Results  window automatically opens and  displays the  
full information for any edit errors that exist, or lets you know that there are no errors.  
The Edit Set Results window lists the total number of edit errors for the abstract, missing  
critical (required) fields, and the edit errors.  For each edit error, the failed edit  name, 
error message, and fields involved in the edit are listed.  Using the information listed in  
the Edit  Set Results window to  help you resolve the edit errors, you can click on a link to  
a  field  to move to it in the data entry  grid and make corrections:  
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Links to 
fields in data 
entry grid 

When greater detail regarding the edit is required to resolve the edit error, click on the 
Edit Description link, which expands to display the edit description; once opened, you 
can click anywhere to close the edit description: 
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Click Edit Description link 
to open description; click 
anywhere to close 
description 

c.  Edit errors can  be viewed for the entire abstract, or just for individual fields.  You can  
view  all edit errors  for the abstract  as shown above by  clicking on  the EDITS icon  on  
the toolbar , right-clicking and selecting  Run Edits, or by pressing  F8.   
Or you can choose to view edit errors by individual data field by right-clicking and 
selecting Edits Information, or by clicking F2.  In the example shown, the edit errors 
for the individual field of Date of Diagnosis are being viewed: 
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When viewing edit errors for an individual field, you can  switch  from the individual data 

field edit errors view to the all edit errors view by  clicking on the  Show All   
button.  

You can make corrections to fields by clicking on the links to the fields 
in the Edit Set Results windows.  To see your corrections reflected, click 

the Refresh button. 

Activity 7 – Correcting Edit Errors 

To practice correcting edit errors, complete the following steps: 

1. Either save  the abstract, click the  EDITS  button  on the toolbar, or press F8  to run the  
edits.  

	 

Result: The  Edit  Set Results window opens and  displays information regarding any  edit  
errors within the abstract.  

2. 	 In the Edit Set Results window, click on  the  Cause of Death = <BLANK>  link.  

Result: The  application  directs you  to the Cause  of Death field in the  data entry  grid, so  
that you can correct the error.  
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3. 	 Enter  0000  to indicate that the  patient was alive  at last contact, and resolve  the edit error.  

4. Either save  the abstract, click the  EDITS  button  on the toolbar, press F8, or click  
Refresh  to run  the edits.  

	 

Result: The application re-runs the edits.  The Cause of Death edit error is removed from 
the Edit Set Results window, and the Total Edit Errors for Abstract count goes down 
by 1. 

The edit error resolved in this exercise was easy to figure out.  If you 
need further detail regarding the edit error to resolve the error, click 
on the Edit Description link for the failed edit, which will expand 
to display the edit description information. 

Abstracting and Deriving Collaborative Staging Fields 
Abstract Plus 3.1 has some special features to facilitate the abstraction of Collaborative 
Staging (CS) input fields, in particular for the Site-specific Factors (SSFs). 

Abstracting CS Input Fields 
Once the fields of primary site and histology have been entered, each CS input data item has 
a special site-specific look-up associated with it that is accessed by clicking the magnifying 
glass icon to the left of the field or pressing F4. 
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Abstracting CS SSFs 
Abstract Plus allows for automatic defaulting of CS SSFs and running of edits to identify 
required CS fields, automatic filling in of CS Version fields, as well as the blanking out of 
CS input fields for cases diagnosed 2003 and earlier. 

For the filling of the CS Version fields, once the Abstractor enters Primary Site, Histology, 
DxDate and Behavior (in no particular expected order), the fields of CS Version Input 
Current (item #2937) and CS Version Input Original (item #2935) are both automatically 
filled when the Abstractor enters any CS input field. CS Version Derived (item #2936) is 
filled when you derive the CS derived fields. 
Once entered, a check on primary site and histology is run to ascertain whether or not SSF25 
is required for schema identification.  Upon checking the primary site and histology entered: 

1.	 If SSF25 is required for the primary site and histology entered: 
a.	 The SSF25 look-up window for the entered schema will open so that you can 

select a value for SSF25. 
b.	 Once you have entered SSF25, automatic defaulting and disabling of SSFs that 

are undefined for the entered schema will occur. This will enable you to clearly 
discern what SSFs are not required, and which SSFs are required.  The automatic 
defaulting will delineate what SSFs are not defined for the identified schema, and 
the running of edits will delineate what SSFs are required. 

If the primary site  and  histology initially entered are revised to result in a  
different schema, you will be  offered the  option  of clearing all CS input fields 
and re-coding CS for the abstract. Regardless of whether you clear all values 
and re-code CS, or keep existing  values and modify the codes, the above SSF  
defaulting routine will run again for the  newly entered schema.  

2. If SSF25 is not required for the primary site and histology entered: 

Version 2.0 February 2011 66 



     

     

  
  

 
 

 

    
     

 

 

 

 
 

   
    

 

 

Working with Abstracts Abstract Plus Abstractor Training Manual 

a.  SSF25 will be  automatically defaulted and  disabled.  
b.  Automatic defaulting and disabling  of other SSFs that are  undefined  for the  

entered schema  will occur. T his will enable you  to clearly discern what SSFs are  
not  required, and which  SSFs are required.  The automatic defaulting  will 
delineate what SSFs are not defined for the identified schema, and the running of  
edits will delineate what SSFs are required.  

Calculating Derived CS Fields 
To derive the derived CS fields, after the appropriate CS input fields have been entered, place 
the cursor into any of the derived fields and click the calculator icon to the left of the field, or 
press F5. 

CS Fields and Tumors Diagnosed 2003 and Earlier 
One further helpful feature is that upon entry of a Date of Diagnosis of 2003 and earlier, you 
will be offered the option of clearing all CS fields. 

The Clear Collaborative Staging Values window opens 
automatically upon entry of a diagnosis year of less than 2004. 
However, you can clear Collaborative Staging fields at any time by 
using the right-click function of Clear Collaborative Stage Fields 
or pressing F9. 
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Activity 8 – Abstracting and Deriving Collaborative Staging Fields 

To practice abstracting and deriving CS fields and using the CS special help features 
provided by Abstract Plus, complete the following steps: 

1.	 Type 001 in the CS Tumor Size field (or click the magnifying glass icon to have the 
application guide the entry of the value), representing a tumor size of 001 millimeters. 
Press Enter. 

Result: 
a) The CS Version Input Current and Original fields are filled in and disabled. 

b)  Automatic defaulting of SSFs undefined for the entered schema (in this case 
prostate) occurs, and these fields are disabled.  In the example shown, SSF25 is 
automatically defaulted. 

If a SSF is defined for the entered schema, it will not be defaulted, as valid 
values will exist and can be coded for the SSF.  However, there will be 
SSFs that are defined for schemas that are not currently being 
required/collected.  Depending on your reporting requirements, these SSFs 
that are defined but not required may require the entry of 988 (Not 
applicable; information not collected for this case). 
Defined, required SSFs will not be defaulted, and they will be listed as 
edit errors in the Edit Results window. You will need to enter a valid code 
for these SSFs. Defined, not required SSFs will not be defaulted and will 
not be counted as edit errors in the Edit Results window. Depending on 
your reporting requirements (enforced by the edits), these SSFs may either 
be left blank, or may need to be manually filled with 988 (Not applicable; 
information not collected for this case), or 999. 
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In the above example, the prostate schema has been entered, and the CS defaulting routine 
has run. You can see that SSF25 has been defaulted. The remaining SSFs in the display type 
are defined for the entered schema, and so have not been defaulted. You can see which of the 
defined SSFs are required by viewing the Edit Results window. Depending on the reporting 
requirements, the remaining SSFs can either be left blank, or may have to be manually coded 
to 988 (or applicable code for not required). 

Enter the following information into the remaining CS fields either by just typing the value in 
the field or using the advanced search feature to guide your input by clicking on the 
magnifying glass icon to the left of the field: 

Field Value to be Entered 
CS Extension 000 (in situ; non-invasive; intraepithelial) 

CS Tumor Size/Ext Eval 

1 (No prostatectomy done. Evaluation based on 
endoscopic examination, diagnostic biopsy, 
including needle core biopsy or fine needle 
aspiration biopsy, transurethral resection (TURP) or 
other invasive techniques including surgical 
observation without biopsy. No autopsy evidence 
used.) 
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Field Value to be Entered 
CS Lymph Nodes 000 (None; no regional lymph node involvement) 

CS Mets at DX 00 (No; one) 

Site-Specific Factor 1 
(PSA lab value) 

004 (004 ng/ml; actual value with implied decimal 
point) 

Site-Specific Factor 2 (PSA 
interpretation) 010 (Positive; elevated) 

Site-Specific Factor 3 
(Pathologic extension) 

970 – No prostatectomy done within first course of 
treatment 

Site-Specific Factor 8 Leave blank or code 988 (Not applicable; 
information not collected for this case) 

Site-Specific Factor 9 Leave blank or code 988 (Not applicable; 
information not collected for this case) 

Site-Specific Factor 10 Leave blank or code 988 (Not applicable; 
information not collected for this case) 

Site-Specific Factor 11 Leave blank or code 988 (Not applicable; 
information not collected for this case) 

Site-Specific Factor 12 Leave blank or code 988 (Not applicable; 
information not collected for this case) 

Site-Specific Factor 13 Leave blank or code 988 (Not applicable; 
information not collected for this case) 

Site-Specific Factor 14 Leave blank or code 988 (Not applicable; 
information not collected for this case) 

In all example cases and  display types in Abstract Plus, only NPCR  
reporting requirements are enforced.  In the above example, although  
SSFs 8-14 were  defined  for the entered schema (prostate)  and therefore  
were not automatically defaulted/disabled, they  were not required for  
collection  as determined by the running of the edits. If reporting  
requirements do  not require that a value be submitted in these fields, 
they  can be left blank.  If reporting requirements require that a value be  
submitted in these fields, the  proper value to abstract for these fields is 
988 (Not applicable; information  not collected  for  this case).  

Once all CS input fields have been filled in, you must derive the CS derived fields as 
appropriate. Place the cursor in the derived field, and either press F5 or click the calculator 
icon to the left of the field.  In the example shown, the derived fields of Derived SS2000 and 
Derived SS2000 Flag will be calculated or derived (note that these are the only derived fields 
that NPCR requires to be calculated for cases diagnosed 2010 and earlier). 

2. Click the calculator icon to the left of the Derived SS2000 field, or press F5. 

Version 2.0 February 2011 70 



     

     

 
  

  
      

  

 
 

 

    
 

   

   

    
  

   

   

   
  

    
 

   
 

  
 

     
     

  

Working with Abstracts	 Abstract Plus Abstractor Training Manual 

Result: The appropriate derived CS fields are calculated and values are automatically 
filed in.  In the example shown, Derived SS2000 and Derived SS2000---Flag fields are 
calculated and filled.  In addition the CS Version Derived field is also automatically 
filled upon derivation. 

Questions---Abstracting and Saving Information 
Answer these questions about abstracting and saving information in Abstract Plus (the 
answers are in Appendix A, on page 124): 

1.	 How do you know how much data you can enter into any particular text field? 

2.	 How do you open the SEER Hematopoietics Database to obtain coding help for 
hematopoietic and lymphoid neoplasms diagnosed beginning January 1, 2010? 

3.	 How do you save an abstract? 

4.	 What is an Abstract Reference ID (AbsRefID), and when is it generated for an abstracts? 

5.	 How do you know that an abstract contains errors, and where can you find the total 
number of errors that exist in an abstract? 

6.	 Where do you obtain the information you need about any edit errors that exist in an 
abstract? 

7.	 When coding Collaborative Staging fields, what Site-specific Factors are defaulted? 

Completing Abstracts 
As mentioned, you must resolve all edit errors and fill in all critical (required) fields in order 
to complete an abstract. Abstract Plus displays helpful, color-coded edits error count and 
abstract completion status information at the bottom of the abstracting window.  Once you 
have resolved all edit errors and completed all missing critical fields, upon the next save of 
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the abstract, the status information changes from red to green upon completion of the 
abstract: 

Incomplete abstract containing edit errors: 

Complete abstract containing no edit errors: 

Closing Abstracts 
Once you have entered information into an abstract and saved your work, you can close the 
abstract and open it in the future to complete your work.  You can also search for an open 
completed abstracts. 

To close an abstract, complete these steps: 

1. Abstracts can be closed in 3 ways: 

a.  Click on  the  File  menu, and  select Close  Abstract.  

b.  Click the Save icon  on the tool bar . 
c.  Use the keystroke  Alt+C.  

Result: The abstract is closed, and you are returned to the Abstract Plus main window. 
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Activity 9 – Completing and Closing an Abstract 

Using what you have just learned, complete and close the John Doe abstract. 

1. 	 To  complete the John Doe abstract, enter the following information into the  following  
fields, e ither typing the value, using the  drop-down list feature, or using the advanced  
search  feature by clicking on the magnifying  glass icon where available:  

Field Value to be Entered 

Reporting Facility 0000000000 

NPI--Reporting Facility Leave blank (press enter to move to next field) 

Type of Reporting Source 1 – Hosp. inpatient; Managed health plans with 
comprehensive unified records 

Medical Record Number 12312312312 

Primary Payer at DX 10 – Insurance, NOS 

Sequence Number—Hospital 00 

Date of 1st Contact 2007/02/15 

Date of 1st Contact Flag Leave blank (press enter to move to next field) 
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Field Value to be Entered 

Class of Case 
10 - Initial diagnosis AND part or all of first 
course treatment or a decision not to treat done at 
the reporting facility, NOS 

Date of 1st Crs RX--COC 2007/02/23 

Date of 1st Crs RX--COC Flag Leave blank (press enter to move to next field) 

RX Date--Surgery 2007/02/23 

RX Date--Surgery Flag Leave blank (press enter to move to next field) 

RX Summ--Surg Prim Site 19 – Transurethral resection (TURP), NOS 

Reason for No Surgery 0 – Surgery of primary site performed 

RX Date--Radiation Leave blank (press enter to move to next field) 

RX Date--Radiation Flag 11 – RX modality not given; autopsy only 

Rad--Regional RX Modality 00 – No radiation treatment 

RX Summ--Surg/Rad Seq 0 – No radiation and/or no cancer-directed 
surgery 

RX Date--Chemo Leave blank (press enter to move to next field) 

RX Date—Chemo Flag 11 – RX modality not given; autopsy only 

RX Summ--Chemo 00 – None 

RX Date--Hormone Leave blank (press enter to move to next field) 

RX Date--Hormone Flag 11 – RX modality not given; autopsy only 

RX Summ--Hormone 00 - None 

RX Date--BRM Leave blank (press enter to move to next field) 

RX Date--BRM Flag 11 – RX modality not given; autopsy only 

RX Summ--BRM 00 - None 

RX Date--Other Leave blank (press enter to move to next field) 

RX Date--Other Flag 11 – RX modality not given; autopsy only 

RX Summ--Other 0 – None 

RX Summ--Treatment Status 1 – treatment given 

RX Summ--Scope Reg LN Sur 0 – No regional lymph nodes removed 

RX Summ--Surg Oth Reg/Dis 0 – None 

RX Summ--Transplnt Endocr 00 – No transplant or endocrine therapy; autopsy-
only 
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Field Value to be Entered 

RX Summ--Systemic/Sur Seq 0 – No systemic therapy and/or surgical 
procedures 

First Course Calc Method 1 – COC definitions 

Date of Last Contact 2007/02/23 

Date of Last Contact Flag Leave blank (press enter to move to next field) 

Vital Status 1 – Alive 

Follow-up Source 0 – Reported hospitalization 

ICD Revision Number 0 – Patient Alive 

Place of Death 997 (Alive) 

Physician Follow-Up 99999999 (Follow-up physician unknown or ID 
number not assigned) 

NPI—Physician Follow-Up Leave blank 

2.  Click  Save  to save  your work.  

Result:  Edits are run; the  Edit Set Results window  opens and  displays a message  
indicating that no errors remain  on the abstract.  In addition, the  EDITS error count 
and  completion status bars  at the bottom of the abstracting  window turn from  red to 
green  to indicate that the abstract has been  deemed  complete  by the system.   
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3.  Close  the abstract. For more information about how to close an abstract, see  page  72  of  
this training  manual, or click  here.  

Searching for and Opening an Existing Abstract 
We have just learned that you can begin abstracting work by creating a new abstract.  
Another way that you can begin abstracting work is to search for and open an existing 
abstract.  

To find and open an existing abstract, complete these steps: 

1. Existing abstracts can be searched for and opened in 3 ways: 

a.  Click on  the  File  menu, and  select Open/Find Abstract.  
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b.  Click the  Open  icon  on the tool bar . 
c.  Use the keystroke  Ctrl+O.  

Result: The Open/Find Abstract window opens. 

Query 
Criteria 

List of Abstracts 
to be Opened 
(Resulting from 
Search) 

The Open/Find Abstract window has two main sections.  The patient query area is 
located in the upper portion of window, and the lower portion of the window displays the 
query results as a list of abstracts from which the abstract of interest can be opened.  
Abstracts listed can be queried by any combination of patient first and last names, 
medical record number, social security number, date of birth, reporting hospital, or 
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Abstract Reference ID.  In addition, abstracts can be queried for by abstract completion 
status by clicking on the appropriate search option at the top of the window. 

If you click the Incomplete Abstracts Only search criteria option, only abstracts for 
which abstraction has not yet been completed will be displayed; this is very helpful 
for identifying abstracts yet to be completed. 

The abstract list window includes these fields and column headings: 

Columns Description 

Name Name of Patient (Last, First) 

Abstract ID A system-generated number identifying the abstract 

Date of Birth Patient’s date of birth 

Social Security # Patient’s social security number 

Sex Patient’s sex 

Acc Num Hosp Hospital accession number reported by the audited facility for 
the reported tumor 

Seq Num Hosp Sequence number hospital reported by the audited facility for the 
reported tumor 

Date 1st Contact Date of 1st contact reported by the audited facility for the 
reported tumor 

Diagnosis Date Diagnosis date of the reported tumor 

Primary Site ICD-O-3 topography code describing the location of the reported 
tumor 

Reporting Hospital COC code for the reporting facility that reported the tumor 

Laterality Code for the side of a paired organ, or the side of the body on 
which the reported tumor originated 

Hist/Beh ICDO3 ICD-O-3 histology and behavior codes for the reported tumor 

Medical Record # Patient’s medical record number 

Date Last Contact Date last contact reported by the audited facility for the reported 
tumor 

Vital Status Patient’s vital status 

Abstract Status The status of the reabstract---incomplete, complete, or held 

The order of the columns on the abstract list window may be modified.  
Simply left-click and hold on the column header, and slide the column to the 
desired position in the column viewing order. 
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2.	 Query for a patient on the list of tumors to be opened. Enter the first letter of the 
patient’s last name in the Last Name search criteria box on the Open/Find Abstract 
window, and click Query. You can also use any of the other available search criteria to 
search upon. In the example shown, the abstract being searched for is for a patient named 
John Doe, so a D is entered in the Last Name search criteria box. 

Result: The Open/Find Abstract window presents the results of the query, and displays 
any potential matches in the tumor list window. 

3.	 From the abstracts listed, locate the abstract of interest and open it, either by double-
clicking the row for the abstract or select the row for the abstract and click Select. 
Result: The Abstract Plus Abstracting window opens so that you can modify the 
abstract that has just been opened.  
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Copying an Abstract 
Thus far we have learned that you can begin abstracting work by creating a new abstract, or 
searching for and opening an existing abstract.  The third way to begin abstracting is to copy 
an existing abstract and modify the information it contains.  The copy feature is especially 
helpful for the reporting of patients with multiple primaries.  Simple open the abstract for the 
first primary for the patient, copy the abstract, and then enter the tumor and treatment 
information for the subsequent primary tumor. 

To copy an abstract, complete these steps: 

1.  Make sure that you  have  the abstract to  be copied  open in the abstracting window.  

2.  Abstracts can be  copied  in  3 ways:  

a.  Click on  the  File  menu, and  select Copy  Abstract.  
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b.  Click the  Copy  icon  on the tool bar . 
c. Use the keystroke Ctrl+I. 

Result: The abstract is copied to a new Abstract Reference ID. Note that the patient 
demographics from the original abstract are copied into the new abstract, so that you need 
only enter information regarding the tumor being abstracted.  Edits are run, and the Edits 
Error Count and Completion Status indicators will indicate that there are errors (missing 
fields) for the abstract and that the abstract is incomplete. 
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3.	 Once you have finished work on the newly copied abstract, save your work, and close the 
abstract. 

If you find an abstract that looks very much like an abstract you want to create for the 
same patient but with a different primary site, you can simply save the abstract as a new 
one and then modify the necessary fields in the new abstract. 

Activity 10 – Finding, Opening, and Copying an Abstract 

Use what you have just learned to practice searching for, opening and copying abstracts, 
complete these steps: 

1.	 Search for and open the John Doe abstract. For more information on finding an 
opening existing abstracts, see page 76 of this training manual, or click here. 

2.	 Now copy the John Doe abstract. For more information on copying abstracts, see page 
80 of this training manual, or click here. 
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An Aside on Abstract Plus ―Projects‖ 
A Project is an avenue for labeling an abstract and grouping abstracts together. With Abstract 
Plus version 2, all abstracts had to be assigned to a ―Project‖.  In Abstract Plus version 2 at 
least one project had to exist in the system, and by default, version 2 of Abstract Plus came 
with a Project called STATE to which each new abstract needed to be physically assigned. 

As the overwhelming majority of Abstract Plus users did not utilize the Projects feature of 
Abstract Plus version 2.0, although the use of Projects is still available, it is no longer 
required.  In Abstract Plus version 3.1, Projects are optional True/False application-specific 
fields that can be added to any display type (in the same manner as any standard NAACCR 
data item).  As a result, unless the central registry intentionally requires a Project field, 
abstracts are no longer required to be assigned to a project.  

Questions---Completing, Finding, and Copying Abstracts: 
Answer these questions about completing, finding, and copying abstracts in Abstract Plus 
(the answers are in Appendix A, on page 125): 

1.	 How do you know when an abstract is complete? 

2.	 How can you locate and open a specific saved abstract? 

3.	 Can you change the information contained in an existing abstract? 

4.	 How can you create a second abstract for a patient using the demographic information 
from an already existing abstract for the patient? 

5.	 Can an abstract exist without being attached to a project? 

Exporting Abstracts 
When exporting abstracts, you can choose to export all abstracts in the abstracts database, 
including complete and incomplete abstracts, or enter criteria for selecting completed 
abstracts for export. Depending on how your Abstract Plus Administrator set up your 
application, the feature for including complete or incomplete abstracts during export may or 
may not be available to you. 

You can export abstracts in NAACCR Layout or Delimited format, depending on options 
selected by your Abstract Plus Administrator upon setup of the program. The default is to 
export abstracts in the NAACCR file format.  However, when enabled, the delimited format 
allows you to select which fields and in what order you would like exported in a comma-
delimited text file. 

To export abstracts, complete these steps: 

1.	 Abstracts can be exported in 3 ways: 

a.	  Click on  the  File  menu, and  select Export Abstracts.  
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b.  Click the  Export icon  on the  tool bar . 
c. Use the keystroke Ctrl+M. 

Result: The Export Abstracts window opens, and presents you with different options for 
exporting abstracts. 

You can modify the default options selected on the export window to export only the 
particular abstracts that you would like to export. 
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The  Mark Exported Abstracts as Exported  and  Export Only Un-
Exported Abstracts To  Date  options are selected by default and  
generally  should  not be changed as these options will prevent re-export of  

 previously  exported abstracts, thus preventing reporting of duplicate 
abstracts to your central registry.  

The Export Abstracts window includes the following options for exporting abstracts: 

Export Option Description 

Export All Abstracts in Database When checked, this option will over-ride any 
other export option, and all abstracts in the 
database will be exported regardless of 
completion status 

Mark Exported Abstracts as 
Exported 

When this option is checked, all exported 
abstracts will be marked as exported; when used 
in combination with the Export Only Un-
Exported Abstracts To Date export option, this 
prevents duplicate export of abstracts 

Export Only Un-Exported 
Abstracts To Date 

When this option is checked, only those 
completed abstracts that have not yet been 
exported will be exported; when used in 
combination with Mark Exported Abstracts as 
Exported export option, this prevents duplicate 
export of abstracts 

Export by Date Created This option allows the user to enter a date range 
to export completed abstracts by the date they 
were created 

Export by Date Previously 
Exported 

This option allows the user to enter a date range 
to export previously exported, completed 
abstracts by the date they were previously 
exported 

Export by Dx Date This option allows the user to enter a date range 
to export completed abstracts by the diagnosis 
date of the tumors reported in the abstracts 

Export by Date Completed This option allows the user to enter a date range 
to export completed abstracts by the date they 
were completed 

Hospital ID This option allows the user to enter a facility ID 
number to export completed abstracts for a 
particular facility 

Project ID For those users with applications set up to collect 
information on Projects, this option allows the 
user to enter a Project ID to export completed 
abstracts for a particular Project 
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Export Option Description 

Abstractor ID This option allows the user to enter an Abstractor 
ID to export completed abstracts for a particular 
Abstractor 

Abstract ID This option allows the user to enter an Abstract 
Reference ID numbe (or range of AbsRefIDs) to 
export specific completed abstracts 

Record Type This option allows the user to enter the Record 
Type of A or M to export completed abstracts of 
either of those Record Types 

The Export All Abstracts in Database function may only be  
available to administrators.  

2.  Select the export options you require, and  Click  Select.  
Result: The system  displays the number of abstracts that meet the export criteria and are  
to  be exported in the lower left-hand corner of the  main window.  

3.  Click  Preview.  


Result: The  Export Selection  Preview  window  opens. 
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4.  Click  Export. 
 
Result:  The  Save As  window  opens. 
 

5. 	 Enter a  file name  for the  export file  in the File  name box and click  Save. I n the example 
shown, the export file is being saved as TestExport.txt.  

Result: The system saves the abstracts into a text file  and  lets you  preview  a report that 
you can print.  
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6.  Close  the report preview  and return to the Export Abstracts window.  

7.  Click  Export Log  to view the log of exported abstracts.  

Result: The  Export Log  window opens. Notice that you can enter a date range or enter  
Select Case ID, and click  Select  to view exports that contain  the specified values.  

8.  Enter  an  export date range  or  specific AbsRefID, and click  Find, or click  Find All 
Exports  to view  all exports in  the  log.  
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Result: Specific fields for exported cases meeting the criteria entered are displayed in the 
lower window. 

9. 	 Click  Close  to return  to the Export Abstracts window and  Close  to return  to the main  
menu.  

Printing Abstracts 
You can print any individual abstract that is open, or you can select one or more abstracts 
from your local database and print them. You can also choose to print the abstracts to a text 
file instead of sending them directly to a printer. 

Printing an Open Abstract 
To print an individual abstract that is open, complete these steps: 

1.	 An opened abstract can be printed in 3 ways: 

a.	  Click on  the  File  menu, and  select Print Current Abstract.  
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b.  Click the  Print icon  on the tool bar . 
c.  Use the keystroke  Ctrl+P.  

Result: The  Abstract Plus Report Viewer  window opens with a print  preview of the  
abstract to  be  printed.  Note that for the majority  of  fields, the coded value and the label 
are printed. Please see page 1 09  of this manual or click  here  to learn  more about using the  
Report Viewer window to view, save and print reports.  
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2. Click Print or Save to print or save the abstract in the format of your choice. 

3. When you are done viewing/printing the abstract, click Close. 

Printing a Range of Abstracts 
To print a range of abstracts, complete these steps: 

1. Printing a range of abstracts can be done in 2 ways: 

a.  Click on  the  File  menu, and  select Print Range of Abstracts.  
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b.  Use the keystroke  Ctrl+R. 
 

Result: The  Print Abstracts  window opens. 
 

2. 	 Enter the abstract selection criteria for the range of  abstracts that you would like to  print. 
You can select the only un-exported Abstracts To Date or All  Abstracts in  Database  
options,  or you can select abstracts by date previously exported, date created, Facility or 
Project ID, Abstractor ID or AbsRefID. In the example shown the  Select the  All  
Abstracts in Database  printing option is checked.  

3. 	 Click  Select.  
Result: The system displays the number of abstracts that meet the selected criteria at the  
bottom  of the window.  
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4. Click Print Preview. 

Result: The Report Viewer window opens with the selected abstracts formatted for 
printing. 
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5.	 When you are done viewing the report, click Print to print the report, Save to save the 
report. 

6.	 Click Close to close the report. 

7.	 Close the Print Abstracts window. 

Questions---Exporting and Printing Abstracts: 
Answer these questions about exporting and printing abstracts in Abstract Plus (the answers 
are in Appendix A, on page 125): 

1.	 How can you avoid exporting duplicate abstracts? 
2.	 How can you see all the abstracts you exported? 

3.	 How can you print multiple abstracts at the same time? 
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Chapter 4: Using Abstract Plus Utilities 
The Utilities menu is used to access a few supplementary functions included in the program, 
such as querying your local database of doctors, managing facility and doctor codes, and 
deleting abstracts.  

To access the Utilities menu items, click on the Utilities menu item and select the desired 
sub-option, or use the appropriate keystroke combination for the desired sub-option. 

Sub-option (Keystroke) Toolbar 
Icon Function 

Doctor Query System 
(Alt+Q) 

Query and search the doctor database; 
DQS can be accessed whether or not an 
abstract is opened, or a physician field 
selected 

Manage Facility Codes… 
Import (can use Alt+I keystroke) or edit 
(can use Alt+J keystroke) local facility 
codes 

Manage Doctor Codes… 
Import (can use Alt+K keystroke) or edit 
(can use Alt+L keystroke) local physician 
codes 

Delete Abstract(s) (Alt+P) Delete selected abstracts 

Notepad (Alt+N) Launch Notepad to view created text files 

The Doctor Query System 
The Abstract Plus Doctor Query System (DQS) allows you to search your local doctor 
database.  The DQS can be accessed whether or not an abstract is opened, or whether or not 
you have a physician field selected in the data entry grid. 

To open the DQS and search for a doctor, complete these steps: 

1. The DQS can be accessed in 2 ways: 

a.  Click on  the  Utilities menu, and  select Doctor Query System.   

a.  Use the keystroke  Alt+Q. 
 

Result: The  Doctor Query System  window opens.   
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2. 	 Enter the search criteria of  your choice and click  Query. The DQS can be searched  by  
doctor name or ID.  

Result: Doctors meeting  the search criteria entered are listed in  the lower portion  of the  
window.   

3.  When  you  have  finished  look-up  doctor codes, click  Close  to close the DQS window.  
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Managing Facility Codes 
Abstract Plus version 3.1 allows you to manage codes for facilities.  The initial list of facility 
codes is added to the application by your Abstract Plus Administrator, however, you can add 
or delete individual facilities to or from the list. 

To manage facility codes, complete these steps: 

1. You can manage facility codes in 2 ways: 

a.  Click on  the  Utilities menu, and  select Manage Facility Codes.   

b.  Use the keystroke  Alt+J. 
 

Result: The  Edit Facility Codes window opens.   


2.  To delete a  facility or facilities from the list, check the  Delete Record  check box for the  
row of the facility or facilities that you would like to  delete.  
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3.	 Click Delete. 

Result: The facility or facilities selected for deletion are deleted from the list. 

4.	 To add a facility or facilities to the list, click Add. 

Result: The application directs you to a new row into which you can enter information 
for the facility such as the facility name and number and add the facility to the list. 
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5. At a minimum, enter the facility name and number, and then click Save. 

Result: The facility is added to the list. 

6. When you are one editing facility codes, click Close. 

Managing Doctor Codes 
Abstract Plus version 3.1 also allows you to manage codes for doctors.  The initial list of 
doctor codes is added to the application by your Abstract Plus Administrator, however, you 
can add or delete individual doctors to or from the list. 

To manage doctor codes, complete these steps: 

1. You can manage doctor codes in 2 ways: 

a.  Click on  the  Utilities menu, and  select Manage Doctor Codes.  
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b.  Use the keystroke  Alt+L. 
 

Result: The  Edit Doctor Codes window opens.   


2.  To delete a  doctor or doctors  from the list, check the  Delete Record  check  box for the  
row of the  doctor or doctors  that you would like to  delete, and click  Delete.  
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Result: The doctor or doctors selected for deletion are deleted from the list.  

3. 	 To add a doctor to the list, click  Add.  

Result: The  application  directs you  to a new row  into which you can enter information  
for the doctor such as the doctor name and  number and add the  doctor to the list.   

4. 	 At a minimum, enter the  doctor name and  number, and then click  Save.  

Result: The doctor is added to  the list.  

5.  When  you are done editing doctor codes, click  Close.  
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Deleting Abstracts 
Abstract Plus version 3.1 allows you to delete abstracts from the abstract database. This 
feature should be used with caution, as abstracts are permanently deleted from the database.  

To delete an abstract, complete these steps: 

1. Abstracts can be deleted in 2 ways: 

a.  Click on  the  Utilities menu, and  select Delete Abstract(s).   

b.  Use the keystroke  Alt+P.
   

Result: The  Delete Abstracts window opens.   
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2. 	 Abstracts to be  deleted can  be searched for via various search criteria: patient name, 
Abstractor’s initials, Abstract Reference ID, Reporting Facility, and export date.  

3. Enter  your search criteria, and click  Query. In the  example shown, the abstract for the  
patient named  John Doe is being searched for and  deleted, so a D is entered in the  patient 
Last Name box.  

	 

Result: Abstracts that match the specified search criteria are displayed in the lower 
portion  of the window. Note that all abstracts listed are selected for deletion.   In the  
example shown, all  patient abstracts with the last name beginning with D are displayed  
and selected for deletion.  

4. 	 To select an individual abstract for deletion from  the  displayed list, click  Select/Deselect 
All.  
Result: All abstracts in the window are deselected.  
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5.  Select individual abstracts for deletion  by checking the  Delete Case  check  box for the 
abstract(s), and clicking  Delete.  

Result: The system verifies that you would like to delete the selected abstract(s), and 
creates a backup database. 

6.  Click  Yes.
  

Result: The system lets you know that the abstract has been  deleted.
  

7.  Click  OK.  

Result: You are returned to the Delete Abstracts window, where the abstract(s) has been  
deleted from the list.  
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8. 	 When  you  have  finished  deleting abstracts click  Close  to close the Delete  Abstracts  
window.  

 

Using the Notepad Function 
The Notepad program is integrated into Abstract Plus under the Utilities menu. Notepad 
allows you to view the contents of a file using the Notepad program without having to 
navigate away from Abstract Plus. 

To use the Notepad feature, complete these steps: 

1.	 The Notepad feature can be opened in 2 ways: 

a.	  Click on  the  Utilities  menu, and  select Notepad.  

b.  Use the keystroke  Alt+N.  

Result: Notepad  opens.  
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2. 	 Click  File  on the Notepad menu and select Open.  
Result: An Open file  windows dialog box opens.  

3. 	 Navigate to the folder and text file that you would like to open, and click  Open.   

Result: The selected file opens in Notepad. 
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4. When you are done viewing the contents of the file, close Notepad. 

Questions---Using Abstract Plus Utilities 
Answer these questions about exporting and printing abstracts in Abstract Plus (the answers 
are in Appendix A, on page 126): 

1. How can you query and search the doctor database in your Abstract Plus application? 

2. How can you delete abstracts? 

3. What is the main benefit of the Notepad integration feature? 
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Chapter  5:  Running  Reports   
Learning Objectives 
In this chapter, you will learn to: 

 Identify the different reports you can run using Abstract Plus 

 Open an Abstract Plus report, and use the various Report Viewer window options to  
maximize  your report viewing experience  

 

 Become familiar with the all of the different file formats in which reports can be 
saved 

Overview 
This chapter covers general information about Abstract Plus reports.  It includes a description 
of all abstract reports offered by the application, how to open the reports, how to use the 
Report Viewer window, and how to print and save reports. 

Available Reports 
The abstracting features of Abstract Plus v3 are supported by a few standard, easy-to-
understand reports that can help facilitate and track abstracting activities. The reports 
included can be upon request using the Reports menu item. The available abstract reports are 
described in the table below. 

Report Description 

Accession Register Includes a line listing of all abstracts in the database, sorted 
by reporting hospital and accession number 

Patient Index Includes a line listing of all abstracts in the database, sorted 
alphabetically by name 

Selected Cases Line listing report which includes abstracts based on user-
specified criteria 

Status Report (Count of 
Cases) Summary… 

Includes the total number of complete and incomplete 
abstracts by export status within a user-specified date range 

Completion Status of 
Abstracts by month 

Includes abstract completion status by year and month of 
Date of Adm/1st Contact within a user-specified date range 

Opening Reports 
To open any of the various abstract reports, complete these steps: 

1. All abstract reports can be opened in 2 ways: 

a.  Click on  the  Reports  menu, and  select  the report of interest.  

b.  Use the appropriate keystroke  designated  on the  Reports  menu to  open the report 
of interest.  For example, to  open the  Accession Register Report, use the  
keystroke  Alt+Shift+A.  
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Result: The report of interest opens in the Abstract Plus Report Viewer window. 

Viewing Reports – The Report Viewer Window 

Page 
Navigation 
Controls 

Can 
Resize 
Panes 

Main 
Toolbar 

Page View 
Controls 

Report 
Being 
Run 

Report 
Thumbnails 

Open 
Search 
Toolbar 

The Abstract Plus Report Viewer window is divided into 2 main sections: a window in which 
to view reports on the left, and a pane for viewing report thumbnails on the right.  When you 
left-click and hold your mouse on the vertical divider bar in the center of the window, a 
splitter appears which you can drag to the left or right to resize the view report and 
thumbnails views.  

The Main Toolbar 

The Report Viewer Main Toolbar includes icons to print and save the report being viewed, as 
well as modify the current view of the report.  The following table describes the function of 
each of the icons on the Main Toolbar, as well as listing keystroke equivalents where 
available for each function. 

Icon Keystroke Function 

Ctrl+P Print the report being viewed; opens the print dialog 
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window 

Ctrl+O Save the report being viewed to various file formats 

Ctrl+Shift+S Change report page setup: size, orientation and margins 

Ctrl+B 

Show/hide the tree of bookmarks of the report being 
viewed; bookmarks are displayed by default---if there are 
no bookmarks in the report the Report Viewer will 
automatically hide the tree of bookmarks 

Ctrl+T Show/hide the thumbnail view of reports in the pane on the 
right 

Ctrl+F Search; Open the Search Toolbar 

F2 View the report in full screen mode 

F3 View the report one page at-a-time 

F4 View the report 2 pages at-a-time 

No keystroke View multiple pages of the report at-a-time; specify 1x2, 
2x3, etc. 

F5 Control page width; when clicked report will enlarge to the 
page width of Report Viewer window 

No keystroke Close a report 

Page Navigation Controls 

Report page navigation controls are located in the lower left-hand corner of the Report 
Viewer window and help you navigate through the various pages of the report being viewed. 
The following table describes the function of each of the page navigation controls. 

Control Function 

View the first page of the report being viewed 

View the previous page of the report being viewed 
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Lists the page number of the current page of the report being viewed 

View the next page of the report being viewed 

View the last page of the report being viewed 

The Search Toolbar 
The search panel is used to search for specific text within the report.  To access feature, click 

the binocular icon on the main toolbar. 

When opened, the Search Toolbar is located in the lower left-hand corner of the Report 
Viewer window directly over the Page Navigation controls. The following table describes the 
function of each of the Search toolbar icons. 

Icon Function 

Closes the Search Toolbar 

Enter the term being searched for in the Find What box 

When clicked, searches the report and finds the next 
occurrence of the search term entered in the Find What 
box 

When checked, the search is repeated with case of the 
search term considered 

When checked, the search is repeated with only whole 
words of the search term considered 

Page View Controls 

Report page view controls are located in the lower right-hand corner of the Report Viewer 
window, and include icons to help you control how many pages of the report to view, as well 
as to zoom in or out on the current report being viewed. The following table describes the 
function of each of the page view controls. 

Control  Keystroke  Function  
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Shift+F2 Single Page: View the report one page at-a-
time 

Shift+F3 Continuous: View the report with all pages 
displayed continuously 

Shift+F4 
Multiple Pages:  based on the selected 
zoom, all possible pages are displayed to 
fill the viewer window 

No keystroke Selected Zoom:  View the report at the 
percent size specified 

Saving Reports 
In order to facilitate the utilization of the information included in the Abstract Plus reports, 
Abstract Plus offers an extensive number of file formats in which the reports can be saved.  
You can save the reports in different file formats in order to further analyze or format the 
data included differently, or you can save the report as an image file to be placed in 
documents and presentations. 

You can save your audit report in any of the file formats listed under the Save As icon on the 
Main Toolbar of the Report Viewer: 
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Accession Register Report 
To run the Accession Register report, complete these steps: 

1. The Accession Register report can be opened in 2 ways: 

a.  Click on  the  Reports  menu, and select  Accession  Register.  
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b.  Use the keystroke  Alt+Shift+A.  

Result: The Accession Register report opens in the Report Viewer window. Notice that 
the accession numbers are displayed in ascending order and grouped by the reporting 
hospital. 

The Accession Register report includes these fields: 

Columns Description 

Rep Hosp COC code for the reporting facility of the abstract 

Acc Num Hosp Hospital Accession Number for the tumor 

Seq Hospital Sequence Number for the tumor 

Name Name of Patient (Last, First) 

Birth Date Patient’s date of birth 

Social Security Patient’s social security number 

Sex Patient’s sex 

Diagnosis Date Diagnosis date of the tumor 

Primary Site ICD-O-3 topography code describing the location of the tumor 

Lateral Laterality code for the laterality of the tumor 
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Columns Description 

Hist/Beh ICDO3 ICD-O-3 histology and behavior codes for the tumor 

Medical Rec Num Patient’s medical record number 

Last Contact Date of Last Contact with the patient 

Abs Ref ID A unique, system-generated number identifying the abstract 

Vital Status Patient’s vital status 

2.	 When you are done viewing the report, click Print to print the report, Save to save the 
report, or Close to close the report. 

Patient Index Report 
To run the Patient Index report, complete these steps: 

1.	 The Patient Index report can be opened in 2 ways: 

a.	  Click on  the  Reports  menu, and select  Patient Index.  

b. 	 Use the keystroke  Alt+Shift+P.  

Result: The Patient Index report opens in the Report Viewer window. Notice that the 
abstracts are displayed in alphabetic order by the name. 

The Patient Index report includes these fields: 
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Columns Description 

Rep Hosp COC code for the reporting facility of the abstract 

Acc Num Hosp Hospital Accession Number for the tumor 

Seq Hospital Sequence Number for the tumor 

Name Name of Patient (Last, First) 

Birth Date Patient’s date of birth 

Social Security Patient’s social security number 

Sex Patient’s sex 

Diagnosis Date Diagnosis date of the tumor 

Primary Site ICD-O-3 topography code describing the location of the tumor 

Lateral Laterality code for the laterality of the tumor 

Hist/Beh ICDO3 ICD-O-3 histology and behavior codes for the tumor 

Medical Rec Num Patient’s medical record number 

Last Contact Date of Last Contact with the patient 

Abs Ref ID A unique, system-generated number identifying the abstract 

Vital Status Patient’s vital status 

2.	 When you are done viewing the report, click Print to print the report, Save to save the 
report, or Close to close the report. 

Selected Cases Report 
To run the Selected Cases report, complete these steps: 

1. 	 The  Selected Cases report can be  opened in  2 ways:  

a.	  Click on  the  Reports  menu, and select  Selected Cases.  

b.  Use the keystroke  Alt+Shift+S.  
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Result: The system displays a window to enter report criteria. 

2.	 Enter report selection criteria, and click Query. Available report selection criteria 
include patient last name, first name, medical record number, social security number, date 
of birth, Abstract Reference ID, reporting hospital, and abstract completion status.  In the 
example shown, the report criterion of Abstract Reference ID numbers 1 to 5 is being 
specified. 

Result: The system displays the cases that meet the entered criteria in the query result 
window. 
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You can further restrict the cases included in the report by un-checking the 
Report Case checkbox in the left-most column of the query window for 
those cases you would like to exclude from the report. 

3. Click Report. 
Result: The Selected Cases report opens in the Report Viewer window. Notice that it 
displays only the cases that fall within the specified range. The system also records and 
displays the SQL statement used to create the report at the top of the report. 
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The Selected Cases report includes these fields: 

Columns Description 

Rep Hosp COC code for the reporting facility of the abstract 

Acc Num Hosp Hospital Accession Number for the tumor 

Seq Hospital Sequence Number for the tumor 

Name Name of Patient (Last, First) 

Birth Date Patient’s date of birth 

Social Security Patient’s social security number 

Sex Patient’s sex 

Diagnosis Date Diagnosis date of the tumor 

Date 1st Contact Date of first contact with the patient 

Primary Site ICD-O-3 topography code describing the location of the tumor 

Lateral Laterality code for the laterality of the tumor 

Hist/Beh ICDO3 ICD-O-3 histology and behavior codes for the tumor 

Medical Rec Num Patient’s medical record number 

Last Contact Date of Last Contact with the patient 

AbsRefID A unique, system-generated number identifying the abstract 

Vital Status Patient’s vital status 

4.	 When you are done viewing the report, click Print to print the report, Save to save the 
report, or Close to close the report. 

Status Report (Count of Cases) Summary 
To run the Status Report (Count of Cases) Summary report, complete these steps: 

1.	 Status Report (Count of Cases) Summary report can be opened in 2 ways: 

a.	  Click on  the  Reports  menu, and select  Status report (Count of Cases) 
Summary.  
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b. 	 Use the keystroke  Alt+Shift+T.  

Result: The system displays a window where you enter a date range, or select all cases in 
the database for the report. 

2.	 Enter the desired date range, or check the Select All Cases in Database check box to 
include all abstracts in the database, and click Preview. In the example shown all 
abstracts in the database are being included in the report. 

Result: The Status Report (Count of Cases) Summary report opens in the Report 
Viewer window displays the summary information for the abstracts. 

The Status Report (Count of Cases) Summary report includes the number of incomplete 
and complete abstracts, stratified by abstract export status. 

3.	 When you are done viewing the report, click Print to print the report, Save to save the 
report, or Close to close the report. 
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Completion Status of Abstracts by Month 
To run the Completion Status of Abstracts by Month report, complete these steps: 

1.	 The Completion Status of Abstracts by Month report can be opened in 2 ways: 

a.	  Click on  the  Reports  menu, and select  Completion Status of Abstracts by  
Month.  

b. 	 Use the keystroke  Alt+Shift+C.  

Result: The system displays a window where you enter a date range, or select all cases in 
the database for the report. 

2.	 Enter the desired date range, or check the Select All Cases in Database check box to 
include all abstracts in the database, and click Preview. In the example shown all 
abstracts in the database are being included in the report. 

Result: The Completion Status of Abstracts by Month report opens in the Report 
Viewer window displays the summary information for the abstracts. 
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The Completion Status of Abstracts by Month report includes the number of incomplete 
and complete abstracts, stratified by diagnosis moth or year, depending on the range of 
dates specified. 

3.	 When you are done viewing the report, click Print to print the report, Save to save the 
report, or Close to close the report. 

Running Custom Reports 
Abstract Plus version 3.1 offers an all-new custom reports feature.  This feature is being 
implemented in phases.  In the first release (version 3.1), custom reports that have been 
generated by the Abstract Plus Development team at CDC can be opened by Abstract Plus 
users.  The various other custom report features, such as being able to generate your own 
report or modify an existing one, will be implemented in future versions of Abstract Plus. 

To open and view a custom report, complete these steps: 

1.	 The custom report can be opened in 2 ways: 

a.	 Click on the Reports menu, and select Run Custom Reports. 

b.  Use the keystroke  Alt+Shift+R. 
 

Result: The Select the Report you would like to Run window opens.
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2.	 Select the custom report you would like to open and click Open. 

Result: The selected report opens in the Abstract Plus Report viewer window. 

3.	 When you are done viewing the report, click Print to print the report, Save to save the 
report, or Close to close the report. 

Questions 
Answer these questions about Abstract Plus reports (the answers are in Appendix A, on page 
126 ): 

1.	 What is the name of the window where you view Abstract Plus abstract reports? 

2.	 How do you print an abstract report? 

3.	 How do you save a report? 
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Appendix A: Answers to Chapter Questions 
Chapter 2:  Abstract Plus General User Basics 
These are the answers to the questions (page 40) about the basics for Abstract Plus general 
users: 

1.	 The first things you need to do upon initial login into Abstract Plus are: 1) create a user 
account, 2) log in, 3) change your password, and then 4) select and answer security 
challenge questions. 

2.	 Your answers to the security challenge questions that you select will be used to validate 
your identity if you forget your Abstract Plus password---if you forget your password, 
Abstract Plus will ask you for the answers you provided to these security questions, and 
then allow you to reset your password if the questions are answered correctly. 

3.	 It is important to have your own user ID and password for Abstract Plus for security 
purposes; never share your account information with others. In addition, when logged in 
using your own user ID and password, your initials will be displayed on the main 
Abstract Plus window to indicate when you are logged in to the application and will be 
automatically recorded in the Abstracted By field when abstracting abstracts or 
conducting audits. This information is recorded in order to associate abstractors with the 
abstracts they have generated, and auditors with the audits that they have conducted. 

4.	 When logging off Abstract Plus, you can use the Backup option to save your work to a 
secure location. 

Chapter 3:  Working With Abstracts 
Creating  Abstracts:
  
Here  are the answers to the  questions on  page  54  about creating an abstract. 


1.	 You can start working with abstracts by importing, creating, or copying abstracts. 

2.	 The Abstract Plus Abstracting window is divided into 2 main sections: a data entry grid 
for coded values on the left, and a data entry grid for text fields on the right.  

Abstracting and Saving Information:
 
Here are the answers to the questions on page 71 about abstracting and saving information.
 

1.	 Each text field has a progress bar beneath it that indicates what percentage of the text 
field has already been filled so that you can properly prioritize entered information. 

2.	 The SEER Hematopoietics Database can be opened from the Histology Lookup window 
(Click on the magnifying glass icon to the left of the Histologic Type ICD-O-3 data item 
or press F4); from the Help menu, or by clicking the Hematopoietic Database icon on the 
tool bar. 

3.	 You can save an abstract in 3 ways: 1) Click on the File menu, and select Save Abstract; 
2) Click the Save icon on the tool bar; 3) Use the keystroke Ctrl+S. 

4.	 Each abstract is assigned an Abstract Reference ID (or AbsRefID), which is a unique, 
system-generated number identifying the abstract.  The AbsRefID is generated upon first 
save of the abstract, and displayed in the upper left-hand corner of the data entry area of 
abstracting window, as well as in the title bar of the application along with the patient 
name. 
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5.	 Color-coded edits error count and abstract completion status information is clearly 
displayed to the user at the bottom of the abstracting window, and edits error count is 
displayed in red if any errors exist (changes from red to green upon completion of the 
abstract). 

6.	 When edits are run, the Edit Set Results window automatically opens and displays the 
full information for any edit errors that exist, or lets you know that there are no errors.  
The Edit Set Results window lists the total number of edit errors for the abstract, missing 
critical (required) fields, and the edit errors.  For each edit error, the failed edit name, 
error message, and fields involved in the edit are listed.  When greater detail regarding 
the edit is required to resolve the edit error, you can click on the Edit Description link in 
the Edit Set Results window, which expands to display the edit description. 

7.	 If SSF25 is required for the primary site and histology entered, you will first be directed 
to enter SSF25.  Once you have entered SSF25, automatic defaulting and disabling of 
SSFs that are not defined for the entered schema will occur. The automatic defaulting 
will delineate what SSFs are not defined for the identified schema, and the running of 
edits will delineate what defined SSFs are required. 

Completing, Finding, and Copying Abstracts:
 
Here are the answers to the questions on page 83 about completing, finding, and copying
 
abstracts:
 

1.	 You must resolve all edit errors and fill in all critical (required) fields in order to 
complete an abstract. Abstract Plus displays helpful, color-coded edits error count and 
abstract completion status information at the bottom of the abstracting window.  Once 
you have resolved all edit errors and completed all missing critical fields, upon the next 
save of the abstract, the status information changes from red to green upon completion of 
the abstract. 

2.	 You can locate a saved abstract by selecting the Open/Find Abstract option under the File 
menu or clicking the Open/Find Abstract icon on the tool bar. 

3.	 Yes, you can change the information contained in an existing abstract. Access the 
abstract, update the information, and click the Save button on the tool bar. 

4.	 Open the existing abstract for the patient and use the Copy Abstract option under the File 
menu to copy the demographic information in the abstract to a new abstract. Abstract 
information on the new tumor as needed. 

5.	 Yes. Since the overwhelming majority of Abstract Plus users did not utilize the Projects 
feature of Abstract Plus version 2.0, although the use of Projects is still available, it is no 
longer required.  In Abstract Plus version 3.1, Projects are optional True/False 
application-specific fields that can be added to any display type (in the same manner as 
any standard NAACCR data item).  As a result, unless your central registry intentionally 
requires a Project field, abstracts are no longer required to be assigned to a project. 

Exporting and Printing Abstracts:
 
Here are the answers to the questions on page 94 about exporting and printing abstracts. 


1.	 You can avoid exporting duplicate abstracts by selecting the following check boxes on 
the Export Abstracts window: Mark abstracts as exported and Export only un-exported 
Abstracts to date. 
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2.	 You can see all the abstracts you have exported by clicking the Export Log button on the 
Export Abstracts window for a detailed export history. 

3.	 You can print multiple abstracts at the same time by selecting Print Range of Abstracts 
from the File menu. 

Chapter 4:  Using Abstract Plus Utilities 
Here are the answers to the questions on page 107 about Abstract Plus utilities. 

1.	 The Abstract Plus Doctor Query System (DQS) allows you to search your local doctor 
database.  The DQS can be accessed whether or not an abstract is opened, or whether or 
not you have a physician field selected in the data entry grid. To open the DQS and 
search for a doctor, click on the Utilities menu, and select Doctor Query System, or use 
the keystroke Alt+Q. 

2.	 Abstract Plus version 3.1 allows you to delete abstracts from the abstract database. This 
feature should be used with caution, as abstracts are permanently deleted from the 
database.  To delete an abstract, click on the Utilities menu, and select Delete Abstract(s), 
or use the keystroke Alt+P. 

3.	 The integrated Notepad feature gives you the ability to view the contents of a file without 
leaving Abstract Plus. 

Chapter 5:  Reports 
These are the answers to the questions (page 123) about reports: 

1.	 The name of the window where you view Abstract Plus reports is called the Abstract Plus 
Report Viewer window. 

2.	 To print a report, you must first open the report in the Report Viewer window.  Click on 
the Reports menu item, and select the sub-option for the report of choice or use the 
appropriate keystroke designated on the Reports menu to open the report in the Report 
Viewer window. To print the report, click the Print icon on the Main Toolbar. 

3.	 To save a report, click on the Save icon on the Report Viewer Main Toolbar, and select 
the desired file format in which you would like to save the report information. 
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Appendix B: Standard Keyboard Shortcuts
 

Function Keyboard Combination 

Menus 

File Menu Alt+ F 

Administration Menu Alt+ M 

Utilities Menu Alt+ U 

Reports Menu Alt+ R 

Options Menu Alt+ O 

Help Menu Alt+ H 

Right-Click Menu: 

Search Help / Field Context F1 

Edits Information for current field F2 

Field Message F3 

Special Field Lookup F4 

CS or Age calculations F5 

Run EDITS on current Abstract F8 

Undo text change Ctrl+ Z 

Cut selected text Ctrl+ X 

Copy selected text Ctrl+ C 

Paste text from clipboard Ctrl+ V 

Delete selected text Alt+ D 

Select All text in entry field Alt+ A 

Move to first Text Field Ctrl+ T 

Section Headings Alt+ S 

Display Types Alt+ T 

General 

Open a pull-down data item listing Alt+ Down Arrow 

Move to next field Enter or Tab 

Move to previous field Shift+Enter or Shift+Tab 
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